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Preface

Ml How to read this manual

Thank you for purchasing the TOSHIBA multifunctional digital systems. This manual describes how to use,
perform maintenance, and fix problems for this equipment. Be sure to read this manual before using this
equipment. Keep this manual handy and retain it for future reference.

0 Symbols in this manual

To ensure correct and safe use of this equipment, this manual describes safety precautions according to the
three levels shown below.
You should fully understand the meaning and importance of these items before reading this manual.

Indicates a potentially hazardous situation which, if not avoided, could result in death,

A\ WARNING serious injury, or serious damage, or fire in the equipment or surrounding assets.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or

A CAUTION moderate injury, partial damage of the equipment or surrounding assets, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Other than the above, this manual also describes information that may be useful for the operation of this
equipment with the following signage:

o Describes handy information that is useful to know when operating the equipment.

0 Pages describing items related to what you are currently doing. See these pages as
required.

0 Description of original/paper direction

Paper or originals of A4 or B5/LT size can be placed either in a portrait direction or in a landscape direction. In
this manual, “-R” is added to this paper size when this size of paper or original is placed in a landscape
direction.

e.g.) A4/LT size original on the original glass

oglo oQl o0l o[Qlo

Placed in a portrait direction: A4/LT Placed in a landscape direction: A4-R/LT-R

Paper or originals of A3 or B4/LD or LG size can only be placed in a landscape direction, therefore “-R” is not
added to these sizes.

O Screens

¢ In this manual, the screens and the operation procedures in Windows are described for Windows 7.
The details on the screens may differ depending on how the equipment is used, such as the status of the
installed options, the OS version and the applications.

* The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT
format, the display or the order of buttons in the illustrations may differ from that of your equipment.
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O Trademarks

For trademarks, refer to the Safety Information.

M Lineup of our manuals

These manuals are provided for the operation of the e-STUDIO2303AM/2803AM. Select and read the manual
best suited to your needs. This manual is the User’s Guide.

Safety Information (Printouts)

This manual describes the necessary precautions for use. For your added security, be sure to read this
manual first.

Quick Guide (Printouts)

This manual describes the components, preparations, basic operations, and troubleshooting for the
equipment.

User’s Guide (PDF file, this manual)

This manual describes preparations for using the e-STUDIO2303AM/2803AM, and how to use functions such
as copying, printing, and scanning. It also describes maintenance and troubleshooting for the problems that
could occur while you are using the equipment.

Software Installation Guide (PDF file)
This manual describes how to install and uninstall printer and scanner drivers.

TopAccess Guide (PDF file)

This manual describes how to use the co-packed utility “TopAccess”. The settings and management of the
equipment can be done using a Web browser.

Help menu for client software

To run the following client software, refer to the Help menu of each:
* Printer driver

» Scan driver

* e-STUDIO Scan Editor

U To read manuals in the PDF file format

This manual in the PDF (Portable Document Format) can be displayed/printed using Adobe Reader or Adobe
Acrobat Reader. If neither is installed in your computer, download one of them. This can be done via the
website of Adobe Systems Incorporated.

B Recommended toner cartridges

To assure optimal printing performance, we recommend that you use only genuine TOSHIBA toner cartridges.
If you use a TOSHIBA-recommended toner cartridge, you can utilize the following three functions of this
equipment:
Cartridge detecting function: This function checks if the toner cartridge is correctly installed and notifies
you if it is not.
Toner remaining check function: This function notifies you when there is little toner remaining in the
cartridge.
Image quality optimization function: This function controls image quality according to the characteristics
of the toner to be used and enables you to print images of an optimal quality.
If you are using a toner cartridge other than the one we recommend, the equipment may not be able to detect
whether it is installed or not. Therefore, even if the toner cartridge is correctly installed, the error message
‘ERROR: TONER” appears on the LCD screen and printing may not be performed. You may also not be able
to utilize the image quality optimization function and the toner remaining check function.
If you are using a toner cartridge other than the one we recommend, toner is not recognized. If this is a
problem for you, please contact your service representative. Remember you will not be able to utilize the
Toner remaining check function and Image quality optimization function as we mentioned.
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Components

B Front/Left side/Inner side

9.

. Reversing Automatic Document Feeder (RADF) (optional)

The stack of originals is scanned one sheet at a time. Both sides of the originals can be scanned. A
maximum of 50 sheets (80 g/m2 or 20 Ib. Bond) can be placed in one go. (The maximum number of sheets
that can be set may vary depending on the media type of the originals.)

P.160 “Paper Misfeed”

Platen sheet
P.176 “Regular Cleaning”

. Original glass

Place the book-type originals and special paper such as overhead transparencies or tracing paper, as well
as plain paper.

. Control panel

Make settings to use the various functions on this equipment.
P.12 “Control panel”

. Toner cartridge

For the recommended toner cartridges, refer to the Safety Information.
P.169 “Replacing Toner Cartridge”

Front cover
Open this when you replace the toner cartridge.
P.169 “Replacing Toner Cartridge”

Drawer
Place up to 250 sheets of plain paper (80 g/m?2 or 20 Ib. Bond).
P.21 “Loading paper in the drawer/Paper Feed Unit’

Paper Feed Unit (optional)
Use the Paper Feed Unit to add the second drawer. A maximum of 250 sheets (80 g/m? or 20 Ib. Bond) of

plain paper can be placed in one go.

Receiving tray

10.Paper exit stopper

Stops large paper from sliding out of the receiving tray.

11.AC-IN terminal (rear)

Connect the power cable supplied with the equipment.
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12.Power switch
Turns the power ON or OFF.
P.15 “Preparation 1 - Turning Power ON”

13.Network interface connector
Use this connector when connecting this equipment to a network.

14.USB terminal (4-pin)
Connect to your PC using a commercially available USB cable.

¢ Use a USB2.0 Hi-Speed certified cable: USB cable supporting the USB2.0 Hi-Speed mode (480
Mbps of transfer speed) certified by the USB Implementers Forum.

¢ Connect the equipment with a PC directly by the USB cable. When it is connected with a PC via a
USB hub, the equipment may not be recognized.

15.Scanning area
The data of originals transported from RADF are scanned here.
P.176 “Regular Cleaning”

16.0riginal scale
Confirm the size of an original placed on the original glass.
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H Right side

1. Platen Cover (optional)
Close this before start copying or scanning.

Depending on the region, the Platen Cover is installed as a standard part.

2. Side cover

3. Bypass tray
Place special paper such as thick paper, overhead transparencies, or tracing paper.
P.23 “Loading paper on the bypass tray”
P.26 “Loading an envelope on the bypass tray”

4. Automatic Duplexing Unit (optional)
Install this to make it possible to print on both sides of paper.

5. USB port
Connect a USB device to store scanned data or print files stored in the USB device.
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H Configuration of options n

The available options are listed below. Contact your service technician or service representative for details. .

P}le:ezggsgecr /—% Reversing Automatic
(KA- ) | Document Feeder

| | (MR-3029)
| Main body

2’4_7 Automatic Duplexing Unit
1 (MD-0107)

= Paper Feed Unit
N (MY-1043)

T S T

Desk
(MH-2507)
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H Control panel

The functions and indications of the > button vary depending on the region. The illustrations show the control
panel for Europe and the Americas unless they are specified.

For Europe and the Americas
3 4 5 6
I I I

1 2
LCOPY LSCAN FU%’]JCS%%NS JOB STATUS | SETTINGS TEMPLATE ENERGY SAVER
Lo s )

FUNCTION CLEAR

e

ORIGINAL AN EXPOSURE @ % -
—— D> |G| el
: u ‘ Y/ Aam @ START
(O ﬂ S@®| ()
DATA ) [, ) | | | |
| | ] 17 16]14] 12 |
21 20 19 18 15 13 11 0 98
For regions other than Europe and the Americas
P 3 4 5 6 7
_.CY _.SZN FUNCTIONS 0B STATUS | SETTINGS |  TEMPLATE VER
: FUNCTION CLEAR
5 OO )
‘ it C A K MNO CLEAR/STOP
= | @@E Il (oo
: ] ‘ Y/ ?-@ START
i 9 ﬂ CO@E @
DATA( . ) [ ) |
| 17 16|14| 12 |
21 20 19 18 15 13 11 98

1. [COPY] button
Press this button to use the copy functions.

2. [SCAN] button
Press this button to use the scan functions.

3. [USER FUNCTIONS] button
Changes the equipment’s default settings.
P.142 “User Functions Menu List”

4. [JOB STATUS] button
Displays the processing status of copy, scan, or print jobs, and also allows you to view their performance
history.
P.152 “Job Status”

5. [SETTINGS] button
Displays the current settings.

6. [TEMPLATE] button
Creates and recalls template settings.
P.66 “Using Templates (Copy)”
P.132 “Using Templates (Scan)”
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7. [ENERGY SAVER] button
Enters into the energy saving mode.

8. [FUNCTION CLEAR] button
Restores all the selected functions to the defaults.

9. [CLEAR/STOP] button
Clears the number entered with the digital keys such as the number of copies, as well as cancels scanning
or copying the original.

10.[START] button
Starts the copying or scanning operation.

11.Digital keys
Enters numbers such as the number of copies or password.

12.[OK] button
Determines the items or operations selected in each menu.

13.> button
Press this button once on the main screen (Copy) to show the “EXPOSURE” screen for Europe and the
Americas, or the “ID CARD” screen for regions other than Europe and the Americas. Press it on menu
screens to move to an item on the right or increase the setting.
P.37 “Using the “EXPOSURE?” or “ID CARD” function quickly”

14./\ button
Press this button on menu screens to move to the item above. If you press this button when the top menu
item is highlighted, the bottom menu item is displayed.

15.V button
Press this button on menu screens to move to the item below. If you press this button when the bottom
menu item is highlighted, the top menu item is displayed.

16.< button
Press this button once on the main screen (Copy) to show the “ORIGINAL MODE” screen. Press it on
menu screens to move to an item on the left or decrease the setting.
P.38 “Selecting “ORIGINAL MODE” quickly”

17.[CANCEL] button
Cancels the current settings and returns to the previous item.

18.Alert lamp
Blinks or lights in case of an error.

19.[DATA] lamp
This lamp blinks while print data is being received.

20.LCD screen
Confirms each menu and error messages.
P.14 “Main screen (Copy)”

21.[DRAWER] button/lamps
Use this button to select a drawer or the bypass tray to be used as a paper source. The lamp of the paper
source currently selected is lit. The lamp blinks when the selected drawer or tray is running out of paper.
When paper in the drawer or on the bypass tray has run out, see the following page to add paper.
P.17 “Preparation 2 - Loading Paper”
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H Main screen (Copy)

Appears after the power of the equipment is turned ON and the warm-up is finished. This screen is called
“main screen (Copy)”. This screen also appears when the AUTO CLEAR function has worked.

sAUTO EXPOSURE
5——TEXT/PHOTO

1. Message
Displays the current status or error messages.

2. Paper size
Displays the paper size specified for the drawer or the bypass tray.

3. Copy quantity
Displays the number of copies.

4. Scroll icon
Displays A or V that you can press on the current screen or menu.

5. Original mode
Displays the mode to copy the original.

6. Exposure
Displays the copy density.

7. Reproduction ratio
Displays the reproduction or zoom ratio to copy.

Tip
This function returns all settings to default without the need to press [FUNCTION CLEAR] on the control
panel. It works when a specified period of time has passed since the last paper exit or the last entry of any

button.
P.144 “GENERAL”
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Preparation 1 - Turning Power ON

M Turning on

1 Press the power switch to “ | ” (on).

Starts warming up, which takes approx. 20 seconds. When the warm-up has finished, the equipment is
ready.

AUTO EXPOSURE -~
TEXT/PHOTO v
Tip

If you press [START] during the warm-up, copying automatically starts after it has finished. When
the job is reserved, “COPYING” appears on the LCD screen to show you the current status.
This function cannot be accessed while “PLEASE WAIT” is being displayed.

The LCD screen below is shown if the equipment is managed under the department
code function.

DEPARTMENT CODE

B:12

Key in a 5-digit department code, and then press [OK].

Tip
If the department code function is enabled, press [FUNCTION CLEAR] after any operation to
prevent unauthorized use of the equipment.

For the details of the department code, see the following page:
P.150 “Department Management”

O Turning off

Press the power switch to “()” (off).

Preparation 1 - Turning Power ON 15




l Saving energy when not in use - Energy saving mode -

To reduce power consumption, the equipment automatically enters into the energy saving mode when a
specified period of time has passed since its last use.

O Types of energy saving mode

Low power mode:“SAVING ENERGY” appears on the LCD screen.
The equipment automatically enters into low power mode when a specified period of time
elapses.

Sleep mode: The LCD screen is turned off and only [ENERGY SAVER] is lit.
The equipment enters into sleep mode when a specified period of time elapses or the
[ENERGY SAVER] button is pressed.

When “Status Monitor” is running, the equipment does not enter into the sleep mode. If you want to enable
the sleep mode, exit it out.
P.78 “Status Monitor”

Tip

The timers for “AUTO POWER SAVE” and “SLEEP MODE” have been set respectively as the factory
default settings. You can change them in the “USER FUNCTIONS” menu.
P.142 “User Functions Menu List”

0 To turn the equipment into the energy saving mode (Sleep mode) manually
Press [ENERGY SAVER].

SETTINGS TEMPLATE ENERGY SAVER
O O

FUNCTION CLEAR
/e ABC DEF
D)
Gl I e CLEAR/STOP
) Ce)
D s

Canceling conditions for energy saving mode
The energy saving mode is canceled under the following conditions.

* When [ENERGY SAVER] or [START] on the control panel is pressed.
- For the low power mode: Press [ENERGY SAVER] or [START]
- For the sleep mode: Press [ENERGY SAVER]

Press [ENERGY SAVER] for at least 0.5 seconds.

* When printing or scanning is performed from a PC connected with this equipment.
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Preparation 2 - Loading Paper

Load an appropriate type of paper.

l Acceptable paper types

Acceptable paper types differ depending on its paper source. See the table below for more details.

(81 - 105 g/m2, 21 - 28 Ib.
Bond)

Thick paper 12
(106 - 163 g/m?,
29 Ib. Bond - 90 Ib. Index)

Thick paper 22
(164 - 216 g/m2, - 80 Ib.
Cover, - 110 Ib. Index)

Tracing paper2 ™7
(75 g/m2, 20 Ib. Bond)

Non-standard size *8:
Length: 100 - 297 mm (3.9" -
11.7"), Width: 148 - 432 (5.8" - 17")

Paper Paper type Paper size Maximum sheet
source capacity™’
Drawer Plain paper A/B format: 250 sheets
(64-80g/m2,17-201b. |A3, A4, A4-R, A5-R, B4, B5, BS-R, | (80 g/m2, 20 Ib. Bond)
Bond) FOLIO
LT format:
LD, LG, LT, LT-R, ST-R, COMP,
13"LG, 8.5"SQ
K format:
8K, 16K, 16K-R
Paper Feed | Plain paper A/B format: 250 sheets
Unit (64-80g/m2,17-201b. | A3, A4, A4-R, AS-R, B4, B5, B5-R, | (80 g/m2, 20 Ib. Bond)
Bond) FOLIO
LT format:
LD, LG, LT, LT-R, ST-R, COMP,
13"LG, 8.5"SQ
K format:
8K, 16K, 16K-R
Bypass tray | Plain paper A/B format: 100 sheets
(64-80g/m2,17-201b. | A3, A4, A4-R, AS-R, B4, B5, B5-R, | (80 g/m2, 20 Ib. Bond)
Bond) FOLIO
. . LT format:
Thin paper® LD, LG, LT, LT-R, ST-R, cOmp, | | Sheet
(52 -63 g/m2, 14 - 16 Ib. 13"LG. 8.5"SQ (52 -63 g/m2, 14 - 16 Ib.
Bond) K format: Bond)
Thick paper™2 8K, 16K, 16K-R 10 sheets

(81 -105 g/m2, 21 - 28 Ib.
Bond)

10 sheets
(106 - 163 g/m2,
29 Ib. Bond - 90 Ib. Index)

10 sheets
(164 - 216 g/m2, - 80 Ib.
Cover, - 110 Ib. Index)

1 sheet

Sticker labels™ "3 1 sheet
Transparencies™? " A4/LT only 1 sheet
Envelope™ "5 "6 DL (110 mm x 220 mm), COM10 (4 | 1 sheet

1/8" x 9 1/2"), Monarch (3 7/8" x 7
1/2"), CHO-3 (120 mm x 235 mm),
YOU-4 (105 mm x 235 mm)

*1 “Maximum sheet capacity” refers to the maximum number of sheets when recommended paper is used. See the following page for

the recommended paper:
3 P.19 “Recommended paper”
*2 2-sided copying is not available.
*3 Sticker labels should not be cut off each other.
*4 Be sure to use the recommended overhead transparencies. Using other transparencies could cause an equipment malfunction.
*5 Printing on the back side of an envelope is not possible.
*6 Envelope can be used when printing from your PC.
*7 For printing the tracing paper, select “THICK1” as the media type.
*8 When loading the paper the size other than standard ones on the bypass tray, select “CUSTOM” as paper size.
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1 PREPARATION

Do not mix various paper sizes in one drawer.

“LT format” is the standard size for only use in North America.
“K format” is a Chinese standard size.

2-sided copying is only available for plain paper.

Tip
Abbreviations for LT format sizes:
LT: Letter, LD: Ledger, LG: Legal, ST: Statement, COMP: Computer
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B Recommended paper

To ensure the best copy performance, the paper types listed below are recommended. If you want to use

paper other than that we recommend, contact your service technician.

LT format: Laser/Hammermill

Paper type Product name
Plain paper A/B format: TGIS Paper/Mondi 80 g/m2, 20 Ib. Bond
LT format: TIDAL/Hammermill
K format: Classic Jetset COPY 70 g/m?
PAPER/UPM
Thick paper A/B format: Color Copy/Mondi 90 g/m2, 24 Ib. Bond

A/B format: Color Copy/Mondi

100 g/m?

Thick paper 1

A/B format: Color Copy/Mondi
LT format: Laser/Hammermill

120 g/m2, 32 Ib. Bond

A/B format: Color Copy/Mondi
LT format: Exact Index’/WAUSAU

160 g/m?, 90 Ib. Index

Thick paper 2

A/B format: Color Copy/Mondi
LT format: Laser/Hammermill

200 g/mZ2, 80 Ib. Cover

A/B format: Color Copy/Mondi
LT format: Exact Index/WAUSAU

200 g/m2, 110 Ib. Index

Tracing paper

Tracing paper/Ostrich International

75 g/m2, 20 Ib. Bond

Sticker labels

A/B format: 3478/ZWECH-AVERY
LT format: 5165/AVERY

Transparencies "

A/B format: PP2500/3M
LT format: X10.0/FOLEX

Envelope

ColumbianCO138/Westvaco,
No.553/Monarch/mailwell

*1 Be sure to use the recommended overhead transparencies. Using other transparencies could cause an equipment malfunction.
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U Paper types not acceptable

Do not use the types of paper listed below since they may cause paper misfeeds or an equipment
malfunction.
If you use these types of paper, paper misfeeding may occur frequently, a paper misfeeding in which you
cannot easily remove paper from this equipment may occur, or images may continually become dirty.
e Damp paper
* Creased paper
* Wrinkled paper or paper prone to be curled
* Extremely smooth or rough surface paper
* Paper whose surface has had special treatment
* Paper once printed or used on one side
» Sticker labels shown below
- The released paper is visible since its label has been punched out.
- The released paper is visible since a part of its label has peeled off.
- A sticker label which has been cut

=,
v

Q Storing paper

Note the following points when storing paper.

* Wrap the paper in its packaging to prevent it from gathering dust.

* Do not expose the paper to direct sunlight.

* Do not store the paper in a humid location.

» Store the paper on a flat surface to prevent it from becoming curled or creased.
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H Loading paper in the drawer/Paper Feed Unit

You can load paper in the drawer and Paper Feed Unit in the same procedure.

For the acceptable paper, see the following page:
P.17 “Acceptable paper types”

1 Turn the power of the equipment ON.

2 Pull out the drawer carefully.

Press it down until you hear a click sound and it is no longer lifted up.
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4 Load paper face up in the drawer.

5>

» Up to 250 sheets (80 g/m?2 or 20 Ib. Bond) can be loaded. Be sure that the height of the stacked
paper does not exceed the line indicated inside of the trailing guides.
P.17 “Acceptable paper types”

* Fan the paper well before loading it in the drawer, otherwise multiple feeding could occur. Be
careful not to cut your fingers.

* The printable side may be noted on its packaging.

* Never put anything in a vacant space in the drawer after the paper has been loaded. Otherwise,
it may cause paper misfeeds or an equipment malfunction.

* If paper cannot be fed, printing takes a long time after feeding or the quality is poor, turn over the
paper and place it again.

When placing LD size paper

To place LD size paper in the drawer, the end guide needs to be removed. Move it to the left
end while pushing its lower part from both sides, and then pull it upward. Keep it in the pocket
on the front side of the drawer.

Move the end guide to the trailing edge of the paper while pushing its lower part in the
direction of the arrows.

Do not allow any gap between the paper and the end guide in the drawer.
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While holding the green lever of the front side guide, adjust the side guides to the
paper size.

7 Push the drawer straight into the equipment slowly until it stops.

A\ CAUTION

Do not catch your fingers in the drawer when closing it.
This could cause injury.

Register the paper size into the equipment.

When you load paper in the drawer for the first time, register the paper size. Be sure to register it correctly,
otherwise it could cause a paper misfeed.

For the registration, see the following page:

P.29 “Preparation 3 - Registering Paper Size and Type”

Be sure to register the paper size each time you have changed it.

H Loading paper on the bypass tray

The contents of the original(s) are rotated when copied on paper of the following sizes fed from the bypass
tray.

A/B format: A3, A4-R, A5-R, B4, B5-R, FOLIO

LT format: LD, LG, LT-R, ST-R, COMP, 13"LG, 8.5"SQ

K format: 8K, 16K-R

For example, to copy an A5-size original, place the original on the original glass in A5 portrait orientation
and paper on the bypass tray in A5 landscape orientation (A5-R).

To enlarge an A4-size original to A3, place the original on the original glass in A4 portrait orientation and
A3 paper on the bypass tray.

The illustrations below are example of loading A4/LT size paper.
For the acceptable paper, see the following page:
P.17 “Acceptable paper types”
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1 Open the bypass tray.

Release the lever on the left, and then load paper face down and straight on the bypass

tray.

The printable side may be noted on its packaging.
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3 Align the side guides with the edges of the paper, and then push back the lever. n

» Up to 100 sheets of plain paper (80 g/m?2 or 20 Ib. Bond) can be loaded. Be sure that the height of
the stacked paper does not exceed the indicators of the side guides. If paper other than plain is
used, set it one sheet at a time.

* Fan the paper well before loading it on the bypass tray, otherwise multiple feeding could occur.
Be careful not to cut your fingers.

* Do not push the paper forcibly into the entrance of the bypass feeder, otherwise it could cause a
paper misfeed.

* Flatten curled paper before loading it on the bypass tray.

» If paper remains on the bypass tray when loading additional paper on it, release the lever, then
remove all the paper, and then load it again.

Tips

* When you use paper longer than the bypass tray size, pull out the paper holder from the tray.

* Depending on its condition, paper may not be fed for bypass copying. In this case, turn over the
paper and place it again as shown in the figure.
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H Loading an envelope on the bypass tray

For the acceptable envelope sizes, see the following page:
P.17 “Acceptable paper types”

Notes for using envelopes

Do not use the following envelopes, otherwise they may cause a paper misfeed or damage to the equipment.
Badly curled, wrinkled or folded envelopes

Extremely thick or thin envelopes

Wet or damp envelopes

Torn envelopes

Envelopes which include the contents

Non-standard size envelopes (ones with a special shape)
Envelopes with eyelets or windows

Envelopes sealed with adhesive paste or tape
Partly-opened or perforated envelopes

10 Envelopes with special coating on the surface
11.Envelopes with glue or double-sided adhesive tape

©CexNOOrON =
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» Store envelopes at room temperature and away from heat and moisture.
» Paper wrinkling may occur after printing depending on environment or the envelope type or condition.
We recommend printing paper as a sample before doing so in large amounts.

26 Preparation 2 - Loading Paper



Place an envelope on a flat clean surface and press it with your hands in the arrow

directions as shown below to expel air from the inside.
Press it well to prevent the flap from rolling upward.

- =

Correct bent corners of the envelope.

O—Q

2 Open the bypass tray.

3 Release the lever on the left, and then load the envelope face down on the bypass tray.

Place the envelope with its flap side at the front as shown below.

Ef\o
— = !

Y =
>

B

(S

* Do not copy or print on the back of envelopes, otherwise it may cause a paper misfeed or soil

them or the inside of the equipment.
* Printing may be uneven depending on the envelope types.
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1 PREPARATION

4 Align the side guides to the edges of the envelope, and then push back the lever.
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Preparation 3 - Registering Paper Size and Type

When you load or change paper, a pop-up window appears. Follow the instructions to register the items below
in the equipment. n
* For the drawer: the paper size

* For the bypass tray: the paper size and type

Tips
* You can also register the paper size for the drawer in the “USER FUNCTIONS” menu.
P.142 “User Functions Menu List”

* When loading the paper the size other than standard ones on the bypass tray, select “CUSTOM” as
paper size.
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Basic Copy Procedure

Learn the basic copy procedure in this section. For the other various functions, see the following page:
P.39 “Copy Settings”

Make sure that the equipment is ready to copy.

P.15 “Preparation 1 - Turning Power ON”

P.17 “Preparation 2 - Loading Paper”

P.29 “Preparation 3 - Registering Paper Size and Type”

l Acceptable originals

Acceptable originals differ depending on the setting position. See the table below for more details.
If you are using the Reversing Automatic Document Feeder, you can automatically scan a stack of plain paper
originals at one time.

Setting Maximum | Acceptable sizes for automatic Maximum
. Type . . L number of
position size size detection™ sheets
Original Plain paper A3 or LD - -
glass Special paper
Booklets
Reversing Plain paper Other than North America and 50 sheets (80 g/
Automatic Thin paper China: mZ2, 20 Ib. Bond)
Document Thick paper A3, A4, A4-R, A5-R, B4, B5, B5-R (or stack height
Feeder (50-104 g/m2,13 - North America: 9.5 mm)2
27 Ib. Bond) LD, LG, LT, LT-R, ST-R, COMP
China:
A3, A4, Ad-R, A5-R, 8K, 16K, 16K-R

*1 The automatic size detection function is only available when the Reversing Automatic Document Feeder is installed.
*2 The maximum number of sheets acceptable varies depending on the type of original.

0 Maximum number of originals scanned at one time

When you use “CONTINUE SCAN” with the Reversing Automatic Document Feeder (RADF), you can scan up
to 150 original sheets at one time. When the number of sheets to be scanned exceeds 150 or the built-in
memory in the equipment is full, scanning stops and an error message is displayed on the LCD screen. Press
any button on the control panel to delete the scanned data.

U Precautions for Reversing Automatic Document Feeder

Do not use the following types of original as they may cause a paper misfeed or damage to the equipment:
* Originals that are folded or curled

* Originals with carbon copies

* Originals that have been taped, pasted, or cut-out

* Originals that have been clipped or stapled

* Originals with holes or tears

* Originals that are damp

* Originals whose correction fluid or ink has not been dried completely
* Overhead transparencies or tracing paper

* Coated paper (e.g. coated with wax)

* Originals with multiple holes punched (e.g. loose leaf paper)

The following types of originals can be used but need extra care:

* Originals that you cannot slide with your fingers or whose surface is specially treated: They should be
fanned well before loading since they may not be able to be separated from each other at feeding.

* Originals that are folded or curled: They should be smoothed out before being loaded.

When black streaks appear

If the scanning area or the guide area is dirty, image problems such as black streaks may occur. Weekly
cleaning of these areas is recommended.
P.176 “Regular Cleaning”
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H Copying originals
Follow the common basic instructions below to make a copy.

1 Place the original(s).

* Placing originals on the original glass
1) Raise the Platen Cover or the Reversing Automatic Document Feeder.
2) Place the original face down on the original glass.
3) Align the original with the top-left corner of the original glass.
4) Lower the Platen Cover or the Reversing Automatic Document Feeder carefully.

A\ CAUTION

Do not place heavy objects (4 kg/8.8 Ib. or over) on the original glass and do not force it
down.
It may breaks the glass and could cause injury.

* When you copy originals with folds or wrinkles, smooth out the folds and wrinkles first. Then,
place the original on the original glass and close the Platen Cover or the Reversing Automatic
Document Feeder to start copying.

* If a shadow of the folds or wrinkles appears on copies although you smooth out them, adjust the
exposure or use the “BACKGROUND ERASE” function.

Tip

When you use the transparent original such as overhead transparencies and tracing paper, place a
blank plain sheet of paper - the same size or a larger sheet - over the original, otherwise the copied
image could be stained.
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* Placing originals on the Reversing Automatic Document Feeder
1) Align all the originals.
2) Place them face up and align the side guides to the original length.

* The top sheet of the originals will be scanned first.

+ Do not load more than 50 originals (80 g/m?2. 201b. Bond) gt once, and make sure the thickness of
the stack of originals does not exceed 9.5 mm regardless of their size.

* Flatten curled paper before loading it on the Reversing Automatic Document Feeder.

* To prevent long originals (A3, B4, A4-R, LD, LG, COMP, or 8K) from sliding out when, raise the
paper exit stopper. When you have finished using the stopper, lift it slightly and slide it back in.

* To prevent misfeeding, do not leave originals or turn OFF/ON the equipment with originals on the
Reversing Automatic Document Feeder.

2 Press [COPY].

COPY SCAN

F

MC

DATA[ 1 [
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3 Enter the number of copies with the digital keys.

SETTINGS TEMPLATE ENERGY SAVER
O

FUNCTION CLEAR
GDEDED)
GHI JKL NG CLEAR/STOP
C4OCOCeO| oo
PARS TUvV WXYZ

sTART

Aa/12 oot

COCOC) @/

Make the copy settings as required.
P.39 “Copy Settings”

You may not be able to use some combinations of functions.
P.184 “Copying Function Combination Matrix”

5 Press [START] to start copying.

SETTINGS TEMPLATE ENERGY SAVER

O O

FUNCTION CLEAR

. /]@ A;C D3EF

GHI JKL MG CLEAR/STOP
EDIEDIED)
PQRS TUV WXYZ
(C7)HC8)H(9) START

To stop or resume copying, press [CLEAR/STOP] during copying.

SETTINGS TEMPLATE ENERGY SAVER
O O

FUNCTION CLEAR
/@ ABC DEF
cHOH ¢
GHI JKL MNO CLEAR/STOP
CaOCOCo)

PQRS UV WXYZ

Ao7/1 2 8 _?+ START
GOCOGD

Press [OK] or [CANCEL] according to the message displayed on the LCD screen.

When you copy loading originals from the Reversing Automatic Document Feeder (RADF):

If there are more originals, place the next ones, select “SCAN NEXT” using V or A and press [OK]. If
there are no more originals, select “FINISHED” using V or A and press [OK]. (Only when "CONTINUE
SCAN" is set to "ON")
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If originals remain on the Reversing Automatic Document Feeder after pressing [FINISHED] on the
CONTINUE SCAN screen, remove all the originals. Leaving them may cause a paper jam.

When the copying has finished, press [FUNCTION CLEAR] to clear the set copy functions and return to
the main screen (Copy).

* If the paper source runs out of paper, an error message is displayed on the LCD screen and copying
stops. Load paper. The equipment automatically resumes copying after approx. 3 seconds have
passed.

¢ The receiving tray can hold up to 100 sheets. If the excessive paper error occurs, the lamp blinks and
an error message is displayed on the LCD screen. Remove the paper from the tray and press [START]
to resume copying.

* When you use overhead transparencies, remove them one by one every time they are ejected.
Otherwise, they could be curled and not be good for projection.
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QO Shortcut keys

You can access some functions by simply pressing a button.
P.37 “Using the “EXPOSURE” or “ID CARD” function quickly”
P.38 “Selecting “ORIGINAL MODE” quickly”

Using the “EXPOSURE” or “ID CARD” function quickly

On the first screen of Copy mode, the I> button function varies depending on the region. It can work as the
[EXPOSURE] button for Europe and the Americas, or the [ID CARD] button for regions other than Europe and
the Americas. Just press the button to access the “EXPOSURE” or “ID CARD” function so that you can
change the copy density, or you can copy the front and back of a card on a sheet of paper.

P.39 “Adjusting the exposure”

P.52 “Copying both sides of a card on a sheet”

For Europe and the Americas

USER
FUNCTIONS JOB STATUS  SETTINGS

O

READY EXPOSURE

/@
100% L1 A4
P[] D)o GO

AUTO EXPOSURE a ( <rrrilonaa
TEXT/PHOTO hd PQRS C|| .

O O &

CANCEL OK

>
1D

For regions other than Europe and the Americas

TEXT/PHOTO hd

\X USER
FUNGTIONS JOBSTATUS  SETTINGS

o O O

READY SET FRONT OF ID CARD
/@
2 o |1
100% L1 A4 * ORIGINAL ID CARD ®< * =]
MODE COPY _on

AUTO EXPOSURE -~ (

O O &

CANCEL OK
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Selecting “ORIGINAL MODE” quickly

On the first screen of Copy mode, the < button can work as the [ORIGINAL MODE] button. Just press the
button to access the “ORIGINAL MODE” function so that you can change the original mode.

P.40 “Selecting the original mode”

For Europe and the Americas

READY

100% [1) A4

AUTO EXPOSURE - *
TEXT/PHOTO -

USER
FUNCTIONS  JOB STATUS

ORIGINAL
MODE

CANCEL OK

SETTINGS

O

For regions other than Europe and the Americas

READY

100% [1) A4

AUTO EXPOSURE - *
TEXT/PHOTO -

USER
FUNCTIONS JOB STATUS

O

ORIGINAL
MODE

O

CANCEL OK

SETTINGS

O

ORIGINAL MODE

ORIGINAL MODE
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Copy Settings

You can make the copy settings on the copy functions menu.

Tip

Press [CANCEL] to exit from the setting without making any changes. You can also exit by pressing <l if it

is active.

H Adjusting the exposure

You can adjust the density to make copies lighter or darker in nine levels from -4 to +4. The auto density
setting can represent the copy image in the middle density status.

Tip

You can directly access this function by pressing >. The button operation varies depending on the region.
For Europe and the Americas:
P.37 “Using the “EXPOSURE” or “ID CARD” function quickly”

READY
100% L1 A4
AUTO EXPOSURE
TEXT/PHOTO v
Menu Functions Settings Description
EXPOSURE AUTO Adjusts the density automatically.
Manual Adjusts the density manually.

Press [COPY].

BWON -

For “AUTO”:
Press [OK].
For manual:

Press V or A to select the item displayed on the LCD screen, and then press [>.
Press V or A to select the setting item.

Adjust the density as follows.

1) Press > or <|to increase or decrease the density level.

2) Press [OK].
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H Selecting the original mode

You can select suitable original image to copy.

Tip

You can directly access this function by pressing <.
P.38 “Selecting “ORIGINAL MODE” quickly”

READY
(2] 100% 1] A4

AUTO EXPOSU
TEXT/PHOTO

RE

Menu Functions Settings Description
ORIGINAL MODE | TEXT/PHOTO Text and photographs mixed.
TEXT Text only, text and thin line, or stamp mark.
PHOTO Photographs only.
BACKGROUND Dark background is placed.
ERASE

1 Press [COPY].

2 Press V or A to select the item displayed on the LCD screen, and then press >.
3 Press V or A to select the setting item, and then press [OK].
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H Selecting the paper

You can select the paper source in which the paper of the desired size and type is loaded.
P.17 “Acceptable paper types”

O Selecting the paper source

Menu Functions Settings Description
DRAWER Drawer 1 XX, Drawer 2 | Uses the drawer as the paper source. The variable
XX “XX” indicates the paper size.
Bypass XX Uses the bypass tray as the paper source. Available

only when the paper is loaded on the bypass tray.
The variable “XX” indicates the paper size.

APS Automatic Paper Selection. Detects the size of the
original and selects paper of the same size
automatically.

» This function may not work properly for totally dark originals or originals
with dark borders.

* Available only when the original is placed on the Reversing Automatic
Document Feeder.

Tip

For the detectable original sizes, see the following page:
P.32 “Acceptable originals”

1 Press [COPY].
2 Press V or A to select the item displayed on the LCD screen, and then press [>.

Press V or A to select the setting item.

To select the paper size:

1) Press D>.

2) Press V or A to select the paper size, and then press [OK].
To accept the setting:

Press [OK].
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0 Selecting the bypass tray automatically

When you load paper into the bypass tray, the paper source automatically changes from the drawer to the
bypass tray. The LCD screen automatically changes so that you can easily set the paper size and type for the
bypass tray.

1 Press V or A to select the paper size, and then press [OK].

BYPASS

THICK
THICK1 hd

Remove the paper from the bypass tray after copying is finished. The paper source automatically changes
back to the drawer.
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H Enlarging or reducing the copy size

You can enlarge or reduce the size of copies in the following three ways.
¢ Specify the ratio manually (EJ P.43)

¢ Select a fixed zoom ratio (LJ P.45)

¢ Automatic Magnification Selection (AMS) (EJ P.46)

Q Specifying the ratio manually

READY
2 100% 1] A4

Menu . _—
Functions Settings Description
ZOOM Manual zoom (25 - 100 - 400%) Adjusts the ratio manually.
FIXED ZOOM | A/B format: P.45 “Selecting a fixed zoom ratio”

50% (A3 -> A5), 71% (A3 -> A4),
71% (A4 -> A5), 141% (A4 -> A3),
141% (A5 -> A4), 200% (A5 -> A3),
300%, 400%

LT format:

50% (LD -> ST), 60% (LG -> ST),
65% (LD -> LT), 65% (LT -> ST),
78% (LD -> LG), 78% (LG -> LT),
100% (LT -> LG), 121% (LG -> LD),
129% (LT -> LD), 129% (ST-> LT),
154% (ST -> LG), 200% (ST -> LD),
300%, 400%

K format:

50% (A3 -> A5), 54% (8K -> A5),
64% (A3 -> 16K), 69% (8K -> 16K),
71% (A3 -> A4), 71% (A4 -> A5),
76% (16K -> A5), 76% (8K -> A4),
91% (A3 -> 8K), 91% (A4 -> 16K),
108% (16K -> A4), 108% (8K -> A3),
129% (A4 -> 8K), 129% (A5 -> 16K),
138% (16K -> 8K), 141% (A4 -> A3),
141% (A5 -> A4), 152% (16K -> A3),
182% (A5 -> 8K), 200% (A5 -> A3),
300%, 400%

AMS P.46 “Automatic magnification
selection (AMS)”

1 Press [COPY].
2 Press V or A to select the item displayed on the LCD screen, and then press >>.

Press V or A to select the setting item for manual zoom.
When manual zoom is already selected, this step is not necessary.
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Press [> or <l to increase or decrease the zoom ratio, and then press [OK].
You can keep pressing the button to adjust the ratio quickly.

-4100% »+

FIXED ZOOM
EMS AMS

To make an enlarged or reduced copy of an original placed in portrait direction onto a paper in landscape
direction,select "AMS" for zoom ratio.

P.46 “Automatic magnification selection (AMS)”
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0 Selecting a fixed zoom ratio

Menu . o
Functions Settings Description
ZOOM Manual zoom (25 - 100 - 400%) P.43 “Specifying the ratio
manually”
FIXED ZOOM | A/B format: Selects a fixed zoom ratio.

50% (A3 -> A5), 71% (A3 -> A4),
71% (A4 -> A5), 141% (A4 -> A3),
141% (A5 -> A4), 200% (A5 -> A3),
300%, 400%

LT format:

50% (LD -> ST), 60% (LG -> ST),
65% (LD -> LT), 65% (LT -> ST),
78% (LD -> LG), 78% (LG -> LT),
100% (LT -> LG), 121% (LG -> LD),
129% (LT -> LD), 129% (ST-> LT),
154% (ST -> LG), 200% (ST -> LD),
300%, 400%

K format:

50% (A3 -> A5), 54% (8K -> A5),
64% (A3 -> 16K), 69% (8K -> 16K),
71% (A3 -> A4), 71% (A4 -> A5),
76% (16K -> A5), 76% (8K -> A4),
91% (A3 -> 8K), 91% (A4 -> 16K),
108% (16K -> A4), 108% (8K -> A3),
129% (A4 -> 8K), 129% (A5 -> 16K),
138% (16K -> 8K), 141% (A4 -> A3),
141% (A5 -> A4), 152% (16K -> A3),
182% (A5 -> 8K), 200% (A5 -> A3),
300%, 400%

AMS P.46 “Automatic magnification
selection (AMS)”

1 Press [COPY].
2 Press V or A to select the item displayed on the LCD screen, and then press [>.
3 Press V or A to select “FIXED ZOOM”, and then press [>.

Z0O0OM

100%

A AMS

4 Press V or A to select a zoom ratio, and then press [OK].

To make an enlarged or reduced copy of an original placed in portrait direction onto a paper in landscape
direction,select "AMS" for zoom ratio.
P.46 “Automatic magnification selection (AMS)”
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0 Automatic magnification selection (AMS)

Menu
Functions

Settings

Description

ZOOM

Manual zoom (25 - 100 - 400%)

P.43 “Specifying the ratio
manually”

FIXED ZOOM

A/B format:

50% (A3 -> A5), 71% (A3 -> A4),
71% (A4 -> A5), 141% (A4 -> A3),
141% (A5 -> A4), 200% (A5 -> A3),
300%, 400%

LT format:

50% (LD -> ST), 60% (LG -> ST),
65% (LD -> LT), 65% (LT -> ST),
78% (LD -> LG), 78% (LG -> LT),
100% (LT -> LG), 121% (LG -> LD),
129% (LT -> LD), 129% (ST-> LT),
154% (ST -> LG), 200% (ST -> LD),
300%, 400%

K format:

50% (A3 -> A5), 54% (8K -> A5),
64% (A3 -> 16K), 69% (8K -> 16K),
71% (A3 -> A4), 71% (A4 -> A5),
76% (16K -> A5), 76% (8K -> A4),
91% (A3 -> 8K), 91% (A4 -> 16K),
108% (16K -> A4), 108% (8K -> A3),
129% (A4 -> 8K), 129% (A5 -> 16K),
138% (16K -> 8K), 141% (A4 -> A3),
141% (A5 -> A4), 152% (16K -> A3),
182% (A5 -> 8K), 200% (A5 -> A3),
300%, 400%

P.45 “Selecting a fixed zoom ratio”

AMS

Detects the size of the original and
automatically sets the optimum zoom
ratio for the paper size.

Feeder.

Tip

* This function may not work properly for totally dark originals or originals with dark
borders.
» Available only when the original is placed on the Reversing Automatic Document

For the detectable original sizes, see the following page:
P.32 “Acceptable originals”

1 Press [COPY].

2 Press V or A to select the item displayed on the LCD screen, and then press >.
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3 Press V or A to select “AMS”, and then press [OK].

Z00OM

100%

FIXED ZOOM

To make an enlarged or reduced copy of an original placed in portrait direction onto a paper in landscape
direction,select "AMS" for zoom ratio.

P.46 “Automatic magnification selection (AMS)”
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H Sorting pages

You can sort a number of copied pages in the same order as the original.

NON SORT: Not to sort the copied pages. All copies of the first page are ejected first and then all copies of
subsequent pages are ejected in sequence.

SORT: Sorts the copied pages in the same order as the original and eject all sets of copies in the
same orientation.

ROTATE SORT:When you make several sets of copies, the copies can be sorted and made to exit alternately
one set by one. This is called alternation. You need to place copy paper in one paper source
in a landscape direction and place that of the same size in another paper source in a portrait
direction in advance.

X X X X X X X X

-

Paper of letter, A4, B5, or 16K size can be loaded in drawers or on the bypass tray for “ROTATE SORT".

48
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Tip

When an original is placed on the Reversing Automatic Document Feeder, “SORT” is automatically set.

READY
@] 100% L] a4

NON SORT

Menu Functions Settings
FINISHING NON SORT
SORT
ROTATE SORT

Press [COPY].
Press V or A to select the item displayed on the LCD screen, and then press >.
Press V or A to select the setting item, and then press [OK].

Specify the number of copies to “2” or more.
P.33 “Copying originals”

ON =

When placing the original on the original glass

After the first original is scanned, the LCD screen shows “NEXT ORIGINAL?".

Make sure that “SCAN NEXT PAGE” is selected, place the next original on the original glass, and then press
[OK] or [START]. When all the originals have been scanned, select “FINISHED”, and then press [OK] or
[START] to start copying the scanned originals.

“CANCEL JOB?” is displayed if there is no operation for a certain period.
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H Copying two or four pages on each sheet

You can copy two or four original pages on each sheet of paper.

OFF: Disables this function.

2IN1: Copies two pages on a sheet of paper.

A

A
B A3
1
i =) B
2 2 .
B
A B
2 1 | 2
D cl D
4

» Be sure to set the paper size and density, etc. before selecting [2IN1/4IN1].
* You need to make settings to use the “2IN1/4IN1” function from “USER FUNCTIONS” - “COPY” - “2IN1/

4IN1”.

P.143 “User functions menu items”

This function is not available for some paper sizes. If you have set the unavailable sizes, the LCD

screen shows the error message and you cannot use this function.
P.17 “Preparation 2 - Loading Paper”
P.29 “Preparation 3 - Registering Paper Size and Type”

Copying without specifying paper size and direction of the original pages may result in unexpected

page allocation order or image position.

When a 2-sided original is placed with its top on the left of the Reversing Automatic Document Feeder

in 2in1/4in1 copying, set [IMAGE DIRECTION] to "OFF".

READY
@l 1002 |1] a4

NON SORT
2IN1/4IN1:0FF

Menu Functions

Settings

2IN1/4IN1

OFF

2IN1

4IN1

1 Press [COPY].

2 Press V or A to select the item displayed on the LCD screen, and then press >.

3 Press V or A to select the setting item, and then press [OK] or [>.
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4 Follow the instructions on the LCD screen to use the “2IN1/4IN1” function. You are

instructed to make the following settings.

* ORIGINAL SIZE
Press V or A to select the size of the original.

* ORIG. ORIENTATION
Press > or <l to select the portrait or landscape orientation of the original.

* SET ORIGINAL
Place the originals as shown on the LCD screen. Make sure that you place the original in the same
orientation as the one selected in “ORIG. ORIENTATION".

* NEXT ORIGINAL?
When you place the original on the original glass, this message appears. Press V or A to select
“SCAN NEXT PAGE”. Select “FINISHED” when you have finished scanning your originals.

* When you place the original on the Reversing Automatic Document Feeder, the size of the
original selected in [ORIGINAL SIZE] is disabled as it is detected automatically.

* For original sizes not supported by the Reversing Automatic Document Feeder, specify
[ORIGINAL SIZE] and place the original on the original glass.

* “CANCEL JOB?” is displayed if there is no operation for a certain period.
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H Copying both sides of a card on a sheet

You can copy the front and back of a card on a sheet of paper.

E

Front side Back side

Tip

You can directly enable this function by pressing I>. The button operation varies depending on the region.
For regions other than Europe and the Americas:

P.37 “Using the “EXPOSURE” or “ID CARD” function quickly”

* Be sure to set the paper size and density, etc. before selecting [ID CARD].
* The settings for the area to scan originals and the print position vary from region to region, so that the
area wider than the card frame of the original glass might be scanned depending on the region.

* The upper and left areas (about 4 mm in width) cannot be copied. To copy up to the edges of a card,
place the card apart from the edges of the original glass.

READY
100% 1] A4

2IN1/4IN1:0FF
ID CARD:OFF

Menu Functions
ID CARD OFF

ON

Settings

1 Press [COPY].

2 Press V or A to select the item displayed on the LCD screen, and then press >>.
3 Press V or A to select the setting item, and then press [OK].
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Follow the instructions on the LCD screen to use the “ON” function. You are instructed
to make the following settings.
e SET FRONT OF ID CARD

 SET BACK OF ID CARD
Turn over the card and place the back surface face down on the original glass, and then press
[START].

“CANCEL JOB?” is displayed if there is no operation for a certain period.
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M Erasing the shadow on edges

You can erase the shadow on the edges of copies. When you copy thick books, you can erase the
surrounding shadow with this function. The area to erase can be changed from 4 to 15 mm (0.2 to 0.6") in

increments of 1 mm (0.04").

-

Tips

¢ This function is available only for paper of standard sizes.
 If the original is different from paper in size (the ratios of width and height are different), the shadow

might not be erased on some edges.

Menu Functions Settings
EDGE ERASE OFF
ON

Press [COPY].
Press V or A to select the item displayed on the LCD screen, and then press [>.

Press V or A to select the setting item.

Set the setting as follows.

For “OFF”

Press [OK].

For “ON”

1) Press > or <|to increase or decrease the value for the area to erase.
2) Press [OK].

BN -

Tip
If you just press [OK] for “ON”, the default value of this function is used.
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H Copying right and left pages separately

When you place a booklet-type original on the original glass while it is being opened, the right and left pages

of the opened section can be copied separately on different paper. Also, when the Automatic Duplexing Unit is

installed, they can be copied on both sides of paper. You do not need to move the original on the original n
glass. The book margin width can be set between 8 to 30 mm (0.3 to 1.2") in increments of 1 mm (0.04").

\

A4, B5, LT, and 16K sizes are available for this function.

READY
100% |1 24

EDGE ERASE:OFF

DUAL PAGE:OFF

Menu Functions Settings
DUAL PAGE OFF
ON

1 Press [COPY].
2 Press V or A to select the item displayed on the LCD screen, and then press >>.
3 Press V or A to select the setting item.

Set the setting as follows.
For “OFF”

Press [OK].

For “ON”

1) PressD.

2) Press > or </to increase or decrease the value for the book margin width.
3) Press [OK].

Tip
If you just press [OK] for “ON”, the default value (15 mm (0.6")) of this function is used.
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H Shifting the pages to the right or left

You can shift pages to the right or left. The shifted area can be used as a margin for punching holes or
stapling. The margin can be changed from 4 to 15 mm (0.2 to 0.6") in increments of 1 mm (0.04").

-

READY
@l 1002 1] a4

DUAL PAGE:OFF
IMAGE SHIFT:OFF

Menu Functions Settings
IMAGE SHIFT OFF
LEFT MARGIN
RIGHT MARGIN

1 Press [COPY].
2 Press V or A to select the item displayed on the LCD screen, and then press [>.
3 Press V or A to select the setting item.

Set the setting as follows.

For “OFF”

Press [OK].

For “LEFT MARGIN” or “RIGHT MARGIN”:

1) Press D>.

2) Press > or < to increase or decrease the value for the margin.
3) Press [OK].

Tip
If you just press [OK] for “ON”, the default value (7 mm (0.3")) of this function is used.
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l Copying on one or both sides

You can select whether originals and paper are 1-sided or 2-sided individually. You can make copies of 1-
sided originals into the both sides of paper so that you can save paper.

1> 1 SIMPLEX (IJ P.58 “Copying on one side”) n

/ » /

1> 2 DUPLEX (1 P.59 “Copying on both sides”)

2 > 2 DUPLEX ((J P.59 “Copying on both sides”)

=

2 > 1 SPLIT (2 P.58 “Copying on one side”)

* To scan 2-sided originals automatically, the Reversing Automatic Document Feeder is required.
* To copy on the both sides of paper, the Automatic Duplexing Unit is required.
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0 Copying on one side

You can copy 1-sided or 2-sided originals on the one side of paper.

Menu Functions Settings Description
2-SIDED 1> 1 SIMPLEX 1-sided original -> 1-sided copy.
1> 2 DUPLEX 1-sided original -> 2-sided copy. (L4 P.59)
2> 2 DUPLEX 2-sided original -> 2-sided copy. (Ed P.59)
2>1SPLIT 2-sided original -> 1-sided copy.

1 Press [COPY].
2 Press V or A to select the item displayed on the LCD screen, and then press [>.

3 Press V or A to select the item for copying on one side, and then press [OK].

When placing the original on the original glass

After the first original is scanned, the LCD screen shows “NEXT ORIGINAL?".

Make sure that “SCAN NEXT PAGE” is selected, place the next original on the original glass, and then press
[OK] or [START]. When all the originals have been scanned, select “FINISHED”, and then press [OK] or
[START].

“CANCEL JOB?” is displayed if there is no operation for a certain period.
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0 Copying on both sides

You can copy 1-sided or 2-sided originals on the both side of paper.

For double-sided printing, use plain paper (64 to 80g/m?2).

READY
100% (1) a4

IMAGE SHIFT

:OFF

1 > 1 SIMPLEX

Menu Functions Settings Description
2-SIDED 1> 1 SIMPLEX 1-sided original -> 1-sided copy. (EJ P.58)
1> 2 DUPLEX 1-sided original -> 2-sided copy.
2> 2 DUPLEX 2-sided original -> 2-sided copy.
2>1SPLIT 2-sided original -> 1-sided copy. (EJ P.58)

Press [COPY].

SOON =

“open to left”, or “TABLET” for “open to top”.

When placing the original on the original glass

After the first original is scanned, the LCD screen shows “NEXT ORIGINAL?".
Make sure that “SCAN NEXT PAGE” is selected, place the next original on the original glass, and then press
[OK] or [START]. When all the originals have been scanned, select “FINISHED”, and then press [OK] or

[START].

“CANCEL JOB?” is displayed if there is no operation

for a certain period.

Press V or A to select the item displayed on the LCD screen, and then press [>.
Press V or A to select the item for copying on both sides, and then press [>.
Press V or A to select the finishing mode, and then press [OK]. Select “BOOK” for
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H Adding a page number on the copied paper

You can add a page number on the copied paper.

» »
« «
P.00001 MM-DD-YYYY 11:32AM P.00001

~N7

&

READY 1
2] 100% 1] A4

ANNOTATION:OFF i

Menu Functions Settings
ANNOTATION OFF
PAGE NO.
PAGE No.+DATE/TIME

1 Press [COPY].
2 Press V or A to select the item displayed on the LCD screen, and then press .

3 Press V or A to select the setting item, and then press [OK].
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Hl Removing blank pages

You can skip blank pages in the original when copying.

|

=

;

3
=)

=l] READY
100% |1 A4

ANNOTATION:OFF
OMIT BLANK:OFF

il

;

o

=)

Menu Functions

Settings

OMIT BLANK
PAGE

OFF

ON

1 Press [COPY].

2 Press V or A to select the item displayed on the LCD screen, and then press [>.

3 Press V or A to select the setting item, and then press [OK].
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H Copying different sizes in one go

When different sizes of originals are mixed and placed on the Reversing Automatic Document Feeder, some
combinations of sizes can be copied in one go.
The combination of the original sizes that can be mixed are as follows:

Other than North America: A3 and A4 or B4 and B5

North America: LD and LT or LG and LT-R

When this function sets to “ON”, the equipment is switched to the automatic paper selection mode. In the
automatic paper selection mode, a copy is made on copy paper of the same size as the original. Place
paper whose sizes are the same as those of the originals in the corresponding drawers in advance.

=] READY 1
100% L1 a4

OMIT BLANK:OFF -

MIX-ORIGINAL:OFF Phd

Menu Functions

Settings

MIXED SIZE
ORIGINAL

OFF

ON

1 Press [COPY].

2 Press V or A to select the item displayed on the LCD screen, and then press >.

3 Press V or A to select the setting item, and then press [OK].
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H Image direction

When you make 1-sided portrait originals to 2-sided copy by placing them in a landscape direction, normally
the copied pages are “open to top”. With this function you can make them “open to left”. This function is called

image direction”. n
When you make 2-sided “open to left” portrait originals to 1-sided copy, normally the copied pages exit in a
different direction alternately. With this function, you can make them all exit in the same direction.

Tip

This function is displayed only when the Automatic Duplexing Unit is installed.

1-sided portrait original (placed in a landscape direction) -> 2-sided copy

“‘IMAGE DIRECTION?” set No setting

Nt R R

2-sided “open to left” portrait original -> 1-sided copy

“‘IMAGE DIRECTION?” set No setting

MIX-ORIGINAL:OFF
IMAGE DIRECTION:ON bhd

Menu Functions Settings
IMAGE DIRECTION | OFF
ON

1 Press [COPY].
2 Press V or A to select the item displayed on the LCD screen, and then press [>.

3 Press V or A to select the setting item, and then press [OK] or [>.
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H Continuing the scanning for a copy

When you copy with the Reversing Automatic Document Feeder (RADF), you can select whether you
continue scanning the next originals after the last loaded original is scanned.

IMAGE DIRECTION:OFF
CONTINUE SCAN:ON >

Menu Functions Settings
CONTINUE SCAN | OFF
ON

1 Press [COPY].
2 Press V or A to select the item displayed on the LCD screen, and then press >.

3 Press V or A to select the setting item, and then press [OK].
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H Confirming the current function settings
1 Press [SETTINGS].

SETTINGS TEMPLATE ENERGY SAVER

O O

FUNCTION CLEAR

ABC DEF

/@
a»
il M M CLEAR/STOP
@D @)
GEDIED]ED ——

2 Press V or A to scroll through the menu.
For details on the displayed functions and settings, see the pages below.
P.136 “Copy menu items”

3 When you are finished with confirmation, press [SETTINGS] again.
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Using Templates (Copy)

Once you have set the several functions and settings, you can register up to three of them as “templates” and
recall one of them for frequent use.
H Registering the templates

1 Make settings for the functions to register as a template.
2 Press [TEMPLATE].

SETTINGS TEMPLATE ENERGY SAVER
O O

FUNCTION CLEAR
ABC

./ @ DEF FC
(1 HC2)H(Cs8)

GHI JKL MNO CLEAR/STOP

4 5 6 C (
( PQRS> ( TUV ) ( ) C/©

GO o

GO /

3 Press V or A to select “REGISTRATION”, and then press [>.

TEMPLATE

RECALL

REGISTRATION 4

4 Press V or A to select a template, and then press [OK].

* You can register three templates for copying.
* The settings are overwritten if you select an existing template.
* You can also register and edit templates with TopAccess. For details, refer to the TopAccess Guide.

You can specify the following items in copy templates.

No. Item Name Settings
1 Copy Quantity 1-999

2 Exposure AUTO, MANUAL(14)

3 Original Mode TEXT/PHOTO, TEXT, PHOTO, BACKGROUND ERASE
4 Paper Source Drawer 1~2, Bypass, APS

5 Zoom 25~400%, AMS

6 Finishing NON SORT, SORT, ROTATE SORT
7 Nin1 OFF, 2IN1, 4IN1

8 Nin1-Original size

9 Nin1-Original orientation PORT., LAND.

10 |ID Card OFF, ON

11 | Edge Erase OFF, ON

12 | Edge Erase Adjustment 4~15

13 | Dual Page OFF, ON

14 | Dual Page Adjustment 8~30

15 | Image Shift OFF, LEFT, RIGHT

16 | Image Shift Adjustment 4~15
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No. Item Name Settings

17 | 2-Sided 1>1 SIMPLEX, 1>2 DUPLEX, 2>2 DUPLEX, 2>1 SPLIT
18 | 2-Sided BOOK, TABLET

19 | Annotation OFF, PAGE NO., PAGENO.+DATE/TIME

20 | Omit Blank Page OFF, ON

21 | Mixed Size Original OFF, ON

22 | Image Direction OFF, ON

23 | Continue Scan” OFF, ON

*  This item is available only when the Reversing Automatic Document Feeder (RADF) is installed.

H Recalling a template

1 Press [TEMPLATE].
2 Press V or A to select “RECALL”, and then press [>.

TEMPLATE

REGISTRATION

3 Press V or A to select a template, and then press [OK].
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Before Using the Printer Driver

Before printing, you have to configure the following options:

* Configuration Settings
To use devices installed in this equipment, you must first configure their options on the [Configuration] tab
of the printer driver.
P.70 “Configuring the options”

¢ Department Code
This system can manage jobs by department codes. This feature allows you to manage job counters for
each department code. For example, an administrator can check the number of copies printed by a
specific department.
If the department code function is enabled, enter your department code provided by your administrator.

H Configuring the options

To use this equipment properly, you need to save the configuration of the options installed on the
[Configuration] tab menu after you installed the printer drivers. In the default setting, you can obtain the
configuration data of options installed automatically by opening the [Configuration] tab menu. If SNMP
communication between this equipment and your computer is not available, or you want to configure options
manually, see the following page:

P.70 “Configuring options manually”

Tip

When SNMP communication between this equipment and your computer is enabled, you can retrieve the
option configuration information by clicking [Update Now].

| Enable SMKP Communication
Ipdate Autarnatically
@ Manual

| Update Mow - |

Q Configuring options manually

Setting the [Configuration] tab manually

You need to log in to Windows with the “Administrator” privilege.

Click [Start] and select [Devices and Printers].
The Printers folder appears.

Tips

* For Windows Vista or Windows Server 2008
Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].

* For Windows 8.1 / Windows 10 / Windows Server 2012 R2 / Windows Server 2016
Right-click [Start], then click [Control Panel] > [View devices and printers].

* For Windows Server 2012, see the procedures in the following section.
P.73 “Accessing the printers folder on Windows Server 2012”
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Select your printer, and then click [Printer properties] in the [File] menu.
The printer driver properties dialog box appears.

===
< |# <« Hard... » Devices and... » -+ Search Devices and Printers |
o ik
Edit View Tools Help
2Hat's printing ISEEu-hat': printing = - E@-
v Se®m default printer
Printing preferences
Printer praperties
Create shortcut %3
Delete [ 3
Rename
Properties
Clase
Troubleshoot
Remave device
T / /
bt . " L -
\ﬁ‘ ”%:"/ @'@/
Fax Microsoft XPS TOSHIBA

Document Writer | e-STUDIO!
ries GDI

TOSHIBA e-STUDIOXXXXSeries GDI State: U Default
{ Model: TOSHIBA e-STUDIOXXXXSeries GDI
i.w Category: Printer

* For Windows Vista / Windows Server 2008, click [Properties] in the [File] menu and select your
printer.
* If the [File] menu is not displayed, press [Alt].
 If the dialog box displayed does not allow the printer driver properties to be changed, follow the
procedure below.
- For Windows Vista, click [Run as administrator] and [Properties] in the [File] menu.
If the password entry screen appears, enter the administrator password.
The [User Account Control] dialog box appears. Click [Continue].

- For Windows 7, some tab menus have a '&l‘ button in the printer driver properties. To change the
properties, click on it. If the properties cannot be changed, ask your system administrator.

3 Select the [Configuration] tab menu, and set the following options.

) TOSHIBA e-STUDIOXK{XSeries GDI Properties ==
General | Sharing | Ports | Advanced | Color Management | Securty | Cenfiguration

Model Selection:

=5 TUDIO28034M -

Option

% Automatic Duplexing Unit

Dravers

E— —
H Drawer 1 -

Diaweer Setting
Wersion Information

| Enable SNMP Commurication SMMF Settings

@ Update Automatically
tanual

Update Mow

ook 1 ‘ Cancel | | Apply ‘ | hicin

Model Selection — Select the model name.
Option - Automatic Duplexing Unit — Be sure to select this check box to use the equipment.
Option - Drawers — Select the drawer configuration.

Tip
For more information about each item, see the descriptions about the Configuration tab.
P.93 “[Configuration] tab”
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4 Click [Drawer Settings].

) TOSHIBA e-STUDIOXXXXSeries GDI Properties ==l
General | Sharing | Ports | Advanced | Color Management | Security | Corfiguration
Model Selection:
STUDID2B03AM -
2 Option
% Avtomnatic: Duplexing Unit
Dirawers
L— —————————————
H ‘Draweﬂ "
| Drawer Setting
| Wersion Information E
| Enable SNMP Communication | SMMP Settings |
@ Update Automatically
M anual
Update Mow
0K 3 [ Cancel | [ Apply | [ Heb

The [Drawer Settings] dialog box appears.

5 Set the following options and click [OK].

Drawer Settings @
Paper Size: Paper Type:
Draver 1: [Letier (81726117 ~| [Pain -
Drawer 2 [Letier (8172117 ~| [Plain -
Bypass Tray |Autn v‘ |F‘Iam v|
Restare Defaults |
[ ok ) [ canesl |

Drawer 1 — Select the size of paper that is loaded in the Drawer 1. The paper type for the drawer is

fixed to [Plain].
Drawer 2 — Select the size of paper that is loaded in the Drawer 2. The paper type for the drawer is

fixed to [Plain].
Bypass Tray — Select the size and type of paper that is loaded in the Bypass Tray.

Tips

* Setup items differ depending on the model and the option configuration.
* For more information about each item, see the descriptions about the Drawer Settings.

P.94 “Drawer Settings”
6 Click [Apply] or [OK] to save settings.
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Accessing the printers folder on Windows Server 2012

Follow the steps below to access the printers folder on Windows Server 2012.

Move the cursor to the upper right corner or lower right corner of the computer screen,
and then select [Start] in the menu that appears.

The [Start] screen appears.

2 Right-click in the blank area in the [Start] screen, and then click [All apps] that appears.

test0l &

Budapest, Hungary

The [Apps] screen appears.
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3 Click [Control Panell].
Apps

=] News

s People B Digital C = & | Sound Recorder

Photos ccess y Vord E order =] Command Prompt
Reader p Sticky Notes W Computer
SkyDrive cel E cyglaunch Faxand Control Panel

5 Scan e

Sports Pa @ Tealem M| Windows Journal D-zfaulmkxms
- |

B store St InfoPa = = File Explorer

Travel e ot Office B Calculator B Wordpad @ Help and Support
Video o Character Map XPS Viewer =
eather = o Math Input Panel e Task Manager

] Notepad LW Magnifier

d Paint B, Narrator

The [All Control Panel Items] screen appears.
4 Click [Devices and Printers].

= All Control Panel items o=

[ » Control Panel » Al Control Panel tems vie

Adjust your computer’s settings

& Fomiy Sefcty ® Fie History
) Folder Options A Forts

& Indesing Options @ Intemet Options

@ Language

& Mouse

- and Tools
 Power Options Programs and Features

& Region 5 RemoteApp and Desktop Connections
B Storage Spaces
2L Taskbar

®

The [Devices and Printers] folder appears.

H Setting the department code

When the department code function is enabled on this equipment, you have to enter your department code to
the printer driver.

This allows an administrator to check the number of copies printed by specific department.

Ask your administrator whether you should enter the department code. If you should, obtain the department
code you need to enter.

If the department code is required, you can enter the department code into the [Department Code] box of the
printer as described below to save you having to enter the department code each time you print.

If printing is performed with an incorrect department code, a dialog box indicating that it is incorrect
appears. In this case, enter the correct one or stop transmitting. If the SNMP setting of this equipment is
disabled, this dialog box will not appear, and the job becomes invalid and is deleted. An error report is then
printed out from this equipment.

Tip

A department code needs to be entered every time you begin printing. If you have to use a different
department code for each print job, enter it when you begin printing.
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Entering department code

Click [Start] and select [Devices and Printers].
The Printers folder appears.

Tips

* For Windows Vista or Windows Server 2008
Click [Start] menu, [Control Panel], [Hardware and Sound] and select [Printers].

¢ For Windows 8.1 / Windows 10 / Windows Server 2012 R2 / Windows Server 2016
Right-click [Start], then click [Control Panel] > [View devices and printers].

* For Windows Server 2012, see the procedures in the following section.
P.73 “Accessing the printers folder on Windows Server 2012”

2 Select your printer, and then click [File] menu and select [Printing Preferences].

[E= ol )
@\:’}vlrﬂ‘ < Hard... » Devices and... » '|"'1‘H Search Devices and Printers ol
Edit  View Toals Help
m zﬁat's printing See what's printing > = - @
v | Sefm default printer

Printing preferences

Printer properties %3
Create shartcut

Delete b-
Rename

Properties
Close

Troubleshaot

Remave device

Shnl: il | il

Microsoft XPS ~ TOSHIBA

Document Writer | e-STUDIO: Se
ries GDI

TOSHBA e-STUDIOXCCKSeries GDI  State: @ Default
i Model: TOSHIBA e-STUDIOXXXXSeries GDI
% Category: Printer

» If the [File] menu is not displayed, press [Alt].
* The printing preferences dialog box appears.

3 Display the [Others] tab menu and enter your department code in the [Department
Code] box.

= TOSHIBA e-STUDIOXXXXXSeries PCL6 Printing Preferences =

| Basic | Finishing | Image Quality I Effect | Others ‘

ol II enu Setting

Basic A
Toner Save

Do nat Print Blank Pages

Custam Paper Size

LT Department Code: | o
JJJT 23 JJJ1 23 %

- Y
Wersion Information

[ Graphics || Test | | Restare &l Defaults |

Frofile:
Mone hd
Save Profile Delete

Restore Defaults
Status Monitar

OK Cancel Apply Help

The department code is a 5-digit number.
4 Click [Apply] or [OK] to save the settings.
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Printing From Application

This section describes how to print a document from application.
P.76 “Considerations and limitations”
P.76 “How to print”

B Considerations and limitations

Some print options can be set from both the application and the printer driver, such as collation. If the collation
is set from the application, documents may not be properly printed. If that happens, use the printer driver to
set the collation. Depending on the application, some print options such as the orientation need to be set from
the application. For print options that can be set from both the application and the driver, refer to the manual of
the application.

l How to print

Once you have installed the printer driver and configured it properly, you can print directly from most Windows
applications. Simply choose the Print command from your application.
You can print using the various functions by setting print options on the printer driver.

Printing from Windows applications

The following describes an example for printing from Notepad on Windows 7.

Open a file and select [Print] from the application’s [File] menu.
The [Print] dialog box appears.

2 Select your printer, and then click [Preferences].

)

(= Print
General

Select Printer

= TOSHIBA a-STUDIOXXXXSer'e&GDI

<

Status

Ready

Location:
Comment:

Page Range
@ Al
Selection

4
[

m

F

Prirt to file Preferences
| Find Printer. 2

Mumber of copies: 1

1}l o2l 33

Coma ][ o

The printing preferences dialog box appears.

Tip

The procedures for displaying the properties dialog for the printer driver may be different depending on the
application that you are using. See your application’s manual about displaying the printer properties dialog

box.

76 Printing From Application




3 PRINT FUNCTIONS

3 Set the print options on each tab according to how you want to print.

Basic | Finishing | Image Qualty | Effect | Others|

Qriginal Paper Size:

Frint Paper Size: Manual Scale:

[5ame as Original iz~ = | 100]| 2 ziz5-400)
Paper Source: .
lAuto v] ﬁ
Paper Type: T
[ Piin |

e Murber of Copies:

Profile:
Mome x| oematon
Save Profile Delete @ Portrait () Landscape

1 201999

-

]

Restore Defaults
Status Monitor

[ ok J[ Cancel || Heb |

» Setting the print options varies depending on how you want to print a document.
P.82 “Print options”

4 Click [OK] to save the settings.
5 Click [Print] to print a document.
[ =

General
Select Printer
5 TOSHIBA e-STUDIOXXXXSeries GDI
Ll m J v
Status: Ready [ Print to file
Locatior:
Comment.
Page Range
@ A Mumber of copies: 1 E‘
Selection Cuirent Fage
2131213
1 1
| Print ;‘ [ Cancel ] l Apply ]
N
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Status Monitor

The status monitor is utility software that is installed with the printer driver. It can monitor the current print job
and the current status of the equipment.
P.78 “Monitoring the print status and reporting print errors”

H Monitoring the print status and reporting print errors

You can start the status monitor from the [Status Monitor] button on the printer driver screen. When started,
the status monitor icon appears in the notification area of the Windows taskbar.

e

The icon changes according to the status of the equipment.
« [ is a “Ready” icon that indicates the equipment is ready to print.
« N is a “Warning” icon that prompts you to take action as soon as possible.

« B is an “Error” icon that prompts you to take a troubleshooting action soon.
If any error occurs, the LCD screen also shows the error message.

You can double-click the icon, or right-click it and select “Start” to open the status monitor dialog and see the
detailed information.

Tip

If you right-click the “Status Notify” icon and select “Exit”, the status monitor terminates the operation.

"TOSHIBA e-STUDIOXX Ready ==
—Printer Status——— ~Printer Figure
READY -
1 ¥
Error Recovery: % E
LT ———
1 b
Cancel
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Setting up Print Options

Print Options are the attributes you set to define the way a print job is processed.
P.79 “How to set up”
P.82 “Print options”

Tip

To find the printing instructions for your specific needs, see the procedures in the following section.
P.96 “Printing With Best Functions for Your Needs” n

l How to set up

There are several ways to set print options. How the settings affect printing varies depending on the way you
set the options. The tabs displayed also vary depending on how you display the printer properties.

P.79 “Setting initial values of print options”

P.79 “Setting print options for each print job”

P.80 “Setting print options using profiles”

O Setting initial values of print options

Setting the print options by displaying the printer properties from the Printers folder within the Windows Start
menu will establish the initial values of the options. For example, the paper size setting you most commonly
use, etc., are settings you will not want to change every time you print. It is convenient to set these options as
initial values.

How to display:

1 Click [Start] and select [Devices and Printers].

Tips

* For Windows Vista or Windows Server 2008
Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].

* For Windows 8.1 / Windows 10 / Windows Server 2012 R2 / Windows Server 2016
Right-click [Start], then click [Control Panel] > [View devices and printers].

* For Windows Server 2012, see the procedures in the following section.
P.73 “Accessing the printers folder on Windows Server 2012”

2 Select your printer, and then click [Printing preferences] in the [File] menu.

L Setting print options for each print job

The print options that are set in properties dialog box, which can be accessed from the [Print] dialog box of the
application, are only applied to the current print job, so once you close the application, the options will be
invalid.

How to display:

1 Click the [File] menu and select [Print] on application.

2 Select your printer, and then click [Preferences].

Setting up Print Options 79



0 Setting print options using profiles

Using profiles, you can save the print settings or apply the saved settings to a print job.

In order to print a document using profiles, you must first create the saved profile.
P.80 “Saving profile”

Once you save a profile, you can apply its settings to a print job.

P.81 “Loading profile”

You can also delete unnecessary profiles.

P.81 “Deleting profile”

Saving profile

You can register up to 20 profiles for each printer driver.

1 Configure the print options on each tab.
Setting the print options varies depending on how you want to print a document.
P.82 “Print options”

2 Click [Save Profile] in the Profile group.

1= Printing Preferences @

Basic ‘ Finishing I Image Qua\ityl Hifect | Othersl

Original Paper Size:

B;J Letter [51/211") -

Frint Paper Sjze: [T Marual Seale:

5 Same as Original Size - 100 =

Paper Source: -
|Autn A | %
Paper Type: T ——
[Plein -

EiT
JJJ'I.ZB JJJ'I.ZB
m T Mumber of Copies:
1 S B:

Profile:

None o (Orientation

S |Ie Delete @ Portrait ) Landscape
RestoreW sfaults
Status Monitor

[ ok [ canesl |[ He

The [Profile Name] dialog box appears.

3 Enter the profile name and click [OK].
Prafile Name @

Prafile Name: Filed!

The file name must be up to 63 characters long.

Tips

* If you enter an existing profile name, you are prompted to confirm whether you want to overwrite
it. If you want, click [OK].

* If you try to save more than 20 profiles, a dialog box notifying you that no more can be saved
appears, then the 21st profile is saved as a temporary profile. If you want to register this
temporary profile, delete unnecessary profiles first, and then select [Temporary Profile] to recall
this profile and click [Save Profile] to save it.

* You cannot specify [None] for the profile name.

4 The profile is saved.
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3 PRINT FUNCTIONS

Loading profile

1 Select a profile in the [Profile] box.

Basic | Finishing [ Image Quaity | Effect | Others|

Qriginal Paper Size:
:
Letter (8142 211" -
Print Paper Size: Manual Scale
[Same as Origihal Size <] | 100]| 2 ziz5-400)
Paper Source: -
[Auto '] ﬁ
Paper Type: i I
[Plain -
Hanber o osies
1 2 99y
Profile:
(Orientation
Filell @ Portrait () Landscaps
Restore Defaults k

Lok [ Comee [ e |

The setting options in the profile are reflected on each tab.

To restore the default settings after you select the profile, click [Restore Defaults] on each tab.
Selecting [None] on the [Profile] box will not restore them.

Deleting profile

1 Select the profile that you want to delete in the [Profile] box, and click [Delete].
[momingptemee &=

Basic | Finshing | Image Quaity | Effect [ Others|
Qriginal Paper Size:
--
Letter (8142 x 11" -
Frint Paper Sjze: Manual Scale:
(same as rigihal $izz. = | 100] 2 iz5-400)
Paper Source: -
IAuto '] ﬁ
Paper Type: i I
[Plain -
e e
1 2 99y
Frofile:
(Orientation
@ Portrait () Landscaps
Restore Defaults '“z

Lok [ Comee [ e |

The [Confirm Delete] dialog box appears.
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2 Click [Yes] to delete the selected profile.

Confirm Delete £3

Are you sure you want to delete it?

[ Yes Rg | No

M Print options

This section describes print options in each tab of the printer driver. This section will help you to find the
description of specific print options, or understand their individual functions.

P.84 “[Basic] tab”

P.86 “[Finishing] tab”

P.88 “[Image Quality] tab”

P.89 “[Effect] tab”

P.91 “[Others] tab”

P.93 “[Configuration] tab”

Tip

The following tabs are the setting items which depend on the OS. For their setting procedures and details,
refer to the Operator's Manual or the Help of the OS to be used.

- [General] tab

[Sharing] tab

[Ports] tab

[Advanced] tab

[Color Management] tab

[Security] tab

How to display:

Click [Start] and select [Devices and Printers].
The Printers folder appears.

Tips

* For Windows Vista or Windows Server 2008
Click [Start], [Control Panel], [Hardware and Sound] and select [Printers].

* For Windows 8.1 / Windows 10 / Windows Server 2012 R2 / Windows Server 2016
Right-click [Start], then click [Control Panel] > [View devices and printers].

* For Windows Server 2012, see the procedures in the following section.
P.73 “Accessing the printers folder on Windows Server 2012”
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Select your printer, and then click [Printing preferences] in the [File] menu.
¢ If the [File] menu is not displayed, press [Alt].
* The printing preferences dialog box appears.

1 — ) TOSHIBA e-STUDIOXXX X Series GDI Printing Preferences
g
I Basic | Finishing | Image Quality | Effect | Others : 2
[ Original Paper Size:
L;I [Letter (21/2211") -
Frint Paper Sjze: Manuzl Scale:
| Same a3 Original Size - ‘ 100 =
3 m Paper Source: -
|Autn V‘ %
Paper Type:
T =]
J"T 5 [Ptain -
JJT.Z 3 JJ'I.Z.S
| o || Test | Mumber of Copies:
T - 1 B
rofile:
4 | Mone - ‘ (Orientation
‘ Save Profile Delste @ Portrait Landscape
| Restore Defaults |
| Status Manitor |
_I Hellp
1 1
7 8

1) Printer Name
Displays the name given to the printer driver when it was installed, or the name it displays on the icon in
the Printer folder.

2) Menu Tabs
The menu items of the printer driver are displayed as tabs. Clicking on a tab will display the contents of the
selected tab. The tabs displayed vary depending on the way the print properties are displayed.
- [Basic] tab
Contains basic print operation settings, such as original paper size, print paper size, paper source,
paper type, orientation, and so on.
P.84 “[Basic] tab”
- [Finishing] tab
Allows you to enable sort printing and N-up printing.
P.86 “[Finishing] tab”
- [Image Quality] tab
Allows you to select how images are printed. You can easily select appropriate image quality depending
on the type of job being printed.
P.88 “[Image Quality] tab”
- [Effect] tab
Contains print options that add the effects to your print jobs such as Watermarks, and so on.
P.89 “[Effect] tab”
- [Others] tab
Contains special features such as toner save, and so on.
P.91 “[Others] tab”
- [Configuration] tab
Allows you to configure the device options of the equipment. This tab is only displayed when the printer
properties are accessed from the Printers folder.
P.93 “[Configuration] tab”

3) Preview window
In the Preview window, you can preview how a document will be printed under the current settings of the
printer driver. The image of a page to which the set print options are applied is displayed.

4) Profile
Print option settings can be saved on your memory. You can save print option settings by clicking [Save
Profile] and easily load a setting file by selecting a profile name in the box.
P.80 “Setting print options using profiles”
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5) [OK]
Enters the input settings and complete the print option settings.
6) [Cancel]
Cancels the input settings and exit the print option settings.
7) [Apply]
Enters the input settings without closing the print option settings. This button is only displayed when the

printer properties are accessed from the Printers folder. This button remains grayed out until a setting is
changed.

8) [Help]
Opens the Help for the printer driver.

U [Basic] tab

The [Basic] tab contains basic print operation settings, such as the original paper size, print paper size, paper
source, paper type, orientation, and so on.

= TOSHIBA e-STUDIOXXXXSeries GDI Printing Preferences ==
Basic | Finishing | Image Quality I Effect | Others‘
Original Paper Size: 1
T )
= | Letter (B142x11") - 2
Frint Paper Size: tanual Scale: 3
g Same as Original Size - 100~
Paper Source: 4
(e = -—
- Paper Type: — re— 5
J J |F‘Ia|n V‘
JJT} 3 JJ1.2.3
m T Murnber of Copies: 6
1 2 (1999
Frofile:
Hone - Orientation 7
Save Profile Delete @ Portialt Landscape
Restore Default:
Status Monitor
Cancel Help

1) Original Paper Size
Selects the size of a document to be printed.
Available original paper sizes are listed below:

A4 (210 x 297 mm) * 85"SQ (8 1/2x81/2")

A5 (148 x 210 mm) 16K (195 x 270 mm)

A3 (297 x 420 mm) 8K (270 x 390 mm)

B4 (257 x 364 mm) Env-Com10 (4 1/8 x 9 1/2")

B5 (182 x 257 mm) Env-Monarch (3 7/8 x 7 1/2")
Folio (210 x 330 mm) Envelope DL (110 x 220 mm)
Letter (8 1/2 x 11") Envelope Cho-3 (120 x 235 mm)
Legal (8 1/2 x 14™) Envelope You-4 (105 x 235 mm)
Ledger (11 x 17") Env-C4 (9.02 x 12.76")
Statement (5 1/2 x 8 1/2") Env-C5 (6.38 x 9.02")

Computer (10 1/8 x 14")

13"LG (8 1/2 x 13")

* The default paper size will be [Letter] or [A4] according to the regional setting in the Windows.
* Setup items differ depending on the model.

2) Print Paper Size

Enlarges or reduces a page image to fit exactly in the selected paper size. If you do not wish to enable
enlarge or reduce printing, select [Same as Original Size].
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3) Manual Scale
Enter the scale manually to enlarge or reduce an image. The ratio can be set at between 25 and 400%.

If originals which include thin lines are printed when the zoom ratio is set, the line width may vary.

B

For detailed instructions on how to print with the [Manual Scale] setting, see the following page:
P.96 “Fitting images within paper size”

4) Paper Source
Selects a paper source to print a job in the most suitable paper size. The figure on the right indicates the
paper size set for each paper source. When you select a paper source, the chosen one is indicated with a
green square in the figure.
- Auto — Automatically selects the paper set in this equipment according to the printed document size.
- Drawer 1 — Paper is fed from the Drawer 1.
- Drawer 2 — Paper is fed from the Drawer 2.
- Bypass Tray — Paper is fed from the Bypass Tray.

The selectable values vary depending on the devices installed in this equipment and their configuration
on the [Configuration] tab.

5) Paper Type
Sets the media type of the paper.
- Plain — Printing on plain paper.
- Thick — Printing on thick paper.
- Thick1 — Printing on thick 1 paper.
- Thick2 — Printing on thick 2 paper.
- Transparency — Printing on transparent sheets.
- Thin — Printing on the back side of thin paper.

* When [Drawer 1] or [Drawer 2] is selected in the [Paper Source] box, only [Plain] can be chosen in
the [Paper Type] box.

* When [Envelope] is selected in the [Print Paper Size] box, [Envelope] will be displayed and you
cannot change the paper type.

6) Number of Copies
Sets the number of printed copies. This can be set at between 1 and 999.

7) Orientation
Sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape — The document is printed in the landscape direction.
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O [Finishing] tab

The [Finishing] tab allows you to enable sort printing and N-up printing.

= TOSHIBA e-STUDIOXXXXSeries GDI Printing Preferences ==
Basic | Finishing | Image Quality | Effect | Others
LCopy Handling: 1
4y
1zE0123
2-Side Printing: 2
il &
Mumber of pages per Sheet: 3
g L) (4] 5 o ]
JJJT} 3 JJJ1.2.3 Direction of Print:
————— EHE
| Graphics || Text |
i Draw Borders Around Pages
Frofile:
|Nane "
‘ Save Profile Delete
iy 4
| Restore Default: | I
|Wl Use Custom Margin: Detalls...
F0K | [ Cancdl | [ Ay ][ Heb

1) Copy Handling
Sets how to sort the printed sheets when numerous copies are made for printing.
- Sort Copies — Select this for sort-printing (1, 2, 3... 1, 2, 3...).

TTTTrTTTTl
N

TTTTrTTTTl

TTTTrTTTTl

TTTTrTTTTl

TTTTTT1Trl
TTTTTT1Trl
TTTTTTTT]
TTTTTT1Trl

[
[
[

- Group Copies — Select this for group-printing (1, 1,1...2,2,2... 3, 3, 3...).

N

TTTTTTTTI

TTTTTTTTI

TTTTTTTTI
TTTTTTTTI

IHHHH\
TTTrrrrrl
ITTTTTTTT\
TTTrrrrrl

[
[

- Rotated Sort Copies— Select this for rotate sort-printing.

TTTTTTTTl

TTTTTTTT]
TTTTTTTT
TTTTTTTT]

TTrrrrrrl
TTrrrrrrl
TTrrrrrrl

[
[
[

* [Group Copies] and [Rotated Sort Copies] can be selected only when more than 1 copy is entered at
the [Number of Copies] option.

* For rotated sort copies, you need to set paper of the same size in two paper sources (a drawer and
the bypass tray) in advance, placing one in a landscape direction and another in a portrait direction.
The paper size should be Letter, A4, B5, or 16K.

Tip

For the detailed instructions on how to print with the [Copy Handling] setting, see the following page:
P.97 “Sort printing”
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2) 2-Side Printing

This sets printing on both sides of paper. Select this check box and then the position of the margin for 2-
sided printing.

- Long Edge — Select this to print on both sides of the paper with a margin on the long edge.
Portrait Landscape

Z

1

1
3o
= o
o
= e

Edge — Select this to print on both sides of the paper with a margin on the short edge.
Landscape

-

1

Notes

g

* The default setting is [Long Edge], which varies from destination to destination.
* When the Automatic Duplexing Unit is not installed:

After all reverse sides of paper are printed, load the paper on the bypass tray printed face down, and
press [START] to print the front sides.

* Be sure to select the following settings on the [Basic] tab to use this print option:

- Any paper size other than envelopes from the [Print Paper Size] list. You cannot use envelopes.
- [Plain] from the [Paper Type] list. You cannot use other paper sizes.

Tips

* You can load paper either in a drawer or on the bypass tray to print the front pages for [2-Side
Printing].

* For the detailed instructions on how to print with the [2-Side Printing] setting, see the following page:
P.98 “Printing on both sides of paper”

3) Number of pages per Sheet

Sets the printing of multiple pages on one sheet. The pages are reduced to fit the selected paper size
automatically and printed.

- 2 pages — Prints images from 2 pages arranged on one sheet.

- 4 pages — Prints images from 4 pages arranged on one sheet.

- 6 pages — Prints images from 6 pages arranged on one sheet.

- 8 pages — Prints images from 8 pages arranged on one sheet.

- 9 pages — Prints images from 9 pages arranged on one sheet.

- 16 pages — Prints images from 16 pages arranged on one sheet.
Direction of Print

Sets how the pages are arranged on one sheet.
- Left to Right — Arranges pages horizontally from the left and printed top to bottom on one sheet.

Right to Left — Arranges pages horizontally from the right and printed top to bottom on one sheet.

Left to Right by column — Arranges pages vertically from the top and printed left to right on one
sheet.

Right to Left by column — Arranges pages vertically from the top and printed right to left on one
sheet.

Draw Borders Around Pages
Prints borders around each page.
Tip
For the detailed instructions on how to print with the [Number of pages per Sheet] setting, see the

following page:
P.99 “Printing several pages on one sheet”
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4) Use Custom Margin
Enables you to set the custom margins. You usually set margins in your application. If you cannot set them
in the application, use this option. Select the check box and click [Details] to open the dialog box. Select
[Units], set the right, left, top, and bottom margins, and then click [OK] to enable them.
- Margin — Enter the value from 4.2 to 100 mm/ 0.17 to 3.94 inches.
- Units — Select the unit, [inch] or [mm], for values.
- Restore Defaults — Restores the margins to the default settings.

Custom Margin @

argin
Left:

017 2 inches [0.17 - 3.94]
Bight:
017 2 inches [0.17 - 3.94]
Top:
j 017 2 inches [0.17 - 3.94]
Bottom:
J 017 2 inches [0.17 - 3.94]

Urits:
@ inch T

Fiestore Defaults |

i [ | Cancel

If the application has the function to set margins, be sure to set them in the application.

U [Image Quality] tab

The [Image Quality] tab allows you to select how images are printed.

1 TOSHIBA e-STUDIOXXXXSeries GDI Printing Preferences =

Basic | Finishing | Image Quality | Efect | Others

Smaothing 1

Distinguish Thin Lines

Use Black for All Text

e

LT
JJJW.Z 3 JJJIZ.S
| Graphics | | Text |
Profile:
|Nana "
‘ Save Profile Delete

| Restore Defaults |

| Status Monitar |

Cancel Apply Help

1) Smoothing
Prints texts and graphics smoothly.
2) Distinguish Thin Lines
Select this check box to print thin lines clearly.

3) Use Black for All Text
Prints all texts in 100% black except white texts.
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Q [Effect] tab

The [Effect] tab contains print options that add effects to your print jobs such as Watermarks and Rotate
printing.

= TOSHIBA e-STUDIOXXXXSeries GDI Printing Preferences ==

Basic | Finishing | Image Guality | Effect | Others

W atermark: 1
E | Hone -

Add Edit.. Delete

Print o First Page Qrly

FRotate 180 Degrees 2

LT
JJJT} 3 JJJ1.2.3

Prafile:
Mone hd
Save Profile Delete

Restore Default:
Status Monitor

Cancel HApp Help

1) Watermark
Selects the watermark to be used or edited. The following values except [None] are the default watermarks
that have been registered in the printer driver. Up to 20 new watermarks can be added in this box.
- None — Select this if no watermark is desired.
The following default watermarks are also displayed in the box:
- TOP SECRET
CONFIDENTIAL
DRAFT
ORIGINAL
- COPY

Tip

For the detailed instructions on how to print with the [Watermark] setting, see the following page:
P.100 “Printing with watermarks”

[Add]

Creates a new watermark. The [Watermark] dialog box appears when you click on this.

P.90 “Add/Edit Watermark”

[Edit]

Select a watermark from the [Watermark] box and click it to edit the watermark. The [Watermark] dialog

box appears when you click on this.
P.90 “Add/Edit Watermark”

[Delete]
Select a watermark from the [Watermark] box and click it to delete a watermark.
P.102 “Deleting a watermark”

* The default watermarks can be deleted but, once deleted, they cannot be restored.
* [None] cannot be deleted.

Print on First Page Only
Prints a watermark on the first page only. This setting will become available when any watermark is
selected from the [Watermark] box.
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2) Rotate 180 Degrees
Performs rotation printing of an image.

Add/Edit Watermark

When you click [Add] or [Edit], the [Watermark] dialog box appears and you can create new watermark or edit
selected watermarks.

Watermark =
-y LCaptior: 5
Classified
Faont Wame: 6
] il -
Style: 7
Regular -
Pl = T Font Size: 8
% a 72: pi(6-300)
1 __F>‘<osition Angle: 9
oo 2 [ ’
2 ——— T 90 i 0
+ ingl Frint Style:
3 L 0 5ol 10
@ inch mrn Draw as Outline 11
4 —_— Ceptie W ateimak 2! TR 12
a0 % 4 +
| Restore Defaults - L S 100 1 3
Cancel
1) X Position
e horizontal position of the watermark is displayed. You can change the position usin e horizonta
The h tal t f th t k is displayed. Y h th t the h tal
scroll bar.
2) Y Position
verti iti W rk is di . You ition usi verti
The vertical position of the watermark is displayed. You can change the position using the vertical scroll
bar.
3) Units

Select the unit for the “X Position” and “Y Position” field.

4) [Center Watermark]
Automatically moves the watermark position to the center.
5) Caption
Enter the text of a watermark. You can enter up to 63 characters.
When you are editing a watermark, the selected watermark text is displayed in the box.
The entered text is displayed as the sample image on the left.

6) Font Name
Select the font to be used for the watermark text.
7) Style
Select the font style for the watermark text.
- Reqular — Sets the regular style to the text.
- Bold — Sets the bold style to the text.
- Italic — Sets the italic style to the text.
- Bold Italic — Sets the bold and italic style to the text.

8) Font Size
Enter the font size for the watermark text. The font size can be set from 6 to 300 pt in units of 1 pt.

9) Angle
Enter the degree of angle for rotating the watermark text. The angle can be set from -90 to 90 degrees in
units of 1 degree. You can also set the degree of the angle by moving the scroll bar.

10)Solid
Prints a solid type of watermark.

11)Draw as Outline
Prints a outline type of watermark.
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12)Transparency

Prints a transparent watermark. When you select this, set the brightness from 0 (darker) to 100% (lighter)
in units of 1%. You can also set the brightness using the scroll bar.

13)[Restore Defaults]
Restores the settings displayed in the [Watermark] dialog box to the original factory defaults.

O [Others] tab

The [Others] tab contains print options such as toner saving, and so on.

i1 TOSHIBA e-STUDIOXXXXXSeries PCLG Printing Preferences (==
Easic | Finishing | Image Quality | Effect | Cthers

Default Menu Setting: 1

D Basic -

Taner Save

Do nat Print Blank Pages

wWN

Custom Paper Size

Department Code:

LT
JJJW?S JJJ123

‘ Wersion Information

N o o b

FGaphios I Tew | | Restare All Defaults

Prafile:
Mone b
Save Profile Delete

Fiestore Defaults
Status Monitor

oK Cancel Apply Help

1) Default Menu Setting
Select the default tab that is displayed when you open the printing preferences of the printer driver. Set
frequently used functions as a default menu setting for your convenience.

If you made settings on the [Others] tab menu from the print setting page of the application, they are
restored to the defaults when you close the printer driver.

If you want to resume the settings, set the printer driver from the [Devices and Printers] folder.

P.79 “Setting initial values of print options”

2) Toner Save
Prints in the toner save mode.

When the toner save mode is enabled, printing may become lighter.

3) Do not Print Blank Pages
Select this check box to ignore blank pages for printing.

 If the watermark option is enabled, all pages are printed even when the content is blank.
* If the blank pages have a header or footer, they are printed.

4) Custom Paper Size

Click this to specify the custom paper size. The [Custom Paper Size] dialog box appears when you click
this.

P.92 “Custom Paper Size”
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* In order to set [Custom Paper Size], you must access the printer driver properties from the [Devices
and Printers] folder (Windows Vista / Windows Server 2008: [Printer]), but not from the [Print] dialog
box in the application.

* The [Custom Paper Size] can be set only by an operation with the administrator privilege.

* Paper size cannot be smaller than 100 x 148 mm or larger than 297 x 432 mm.

5) Department Code
Enter the user’s department code if the system is managed with department codes. Please ask your
administrator for your department code.
The department code is a 5-digit number.

6) Version Information
Shows the version of the printer driver.

7) Restore All Defaults
Restores all print options to the default settings.
Click [OK] on the confirmation dialog box to start restoring or [Cancel] to stop it.

Custom Paper Size

In the [Custom Paper Size] dialog box, up to 40 custom paper sizes can be defined. The custom page size
that you specify can be selected in the [Original Paper Size] and [Print Paper Size] box on the [Basic] tab.

The [Custom Paper Size - Paper Size List] dialog box
Custom Paper Size @1

1 Paper Size List:

Name Size:
CustomPaper(2 3.94 x6.89 inch
CustomPaperd3 3.94 x7.87 inch

2 { Add I Delete ] 3

The [Custom Paper Size - Name] dialog box

Custom Paper Size @
4 Mame:

CustomPaper)4

L4 AfLength):

I’A 394 2 inches (3.94 - 12.00)

B —
——— B(Width): 5
9.84 2. inches (5.83 - 47.24)
@ inch ) mm 6
[ oK ] [ Cancel ]

1) Paper Size List
Select the custom paper size that you want to modify.

2) [Add]
Click this to display the [Custom Paper Size - Name] dialog box.

92

Setting up Print Options



3) [Delete]
Click this to clear and restore the default settings of the selected custom paper size that you selected in the
[Paper Size List]. When you click this, the confirmation dialog box appears. Click [Yes] to delete the setting.

4) Name

Enter the custom paper size name. You can enter up to 63 characters. This name will be displayed in the
[Original Paper Size] and [Print Paper Size] box on the [Basic] tab.

5) Paper Size n
Enter A (Length) and B (Width) to specify the paper size.

The selectable range of A (length) and B (width) differs depending on the model. Select values within
the range shown on the right of each.

6) Units
Select the unit for the paper size. The default unit varies depending on the regional setting in the Windows.

* Toregister a custom paper size, either A (Length) or B (Width) should differ by more than 0.3 inches (7
mm) from the standard paper size. If not, the created custom paper size is considered as the standard
paper size.

* You cannot create a custom paper size with A (Length) longer than B (Width). If you want to print such
a document, do so by selecting [landscape] for the [Orientation].

U [Configuration] tab

The [Configuration] tab allows you to configure options. When any optional unit is installed in this equipment,
set the configuration of the machine on this tab. The [Configuration] tab can be displayed only from the
Printers folder (and not when displaying the properties from the application’s print dialog box).

In order to set the [Configuration] tab, you must access the printer driver properties from the [Devices and
Printers] folder (Windows Vista / Windows Server 2008: [Printer]). For detailed instructions on how to set
the [Configuration] tab, see the following page:

P.70 “Configuring options manually”

o) TOSHIBA e-STUDIOXXXXSeries GDI Properties ==
General | Sharing | Ports | Advanced | Color Management | Security | Configuration
Model Selection:
&S TUDINZAN3AM - 1
: Option
% Automatic; Duplexing Unit 2
Drawers
= _—
H |Drawar1 b
| Drawer Setting : 3
| “Yegsion Infarmation : 4
/| Enable SNMP Communication | SNMP Settings i 5
6 @ Update Automatically !
Manual
Update Maw
0K 1 Cameel | [ Aoy | [ Hep

1) Model Selection
This sets the model type.
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2) Option
This option sets whether the following optional devices are installed.

Automatic Duplexing Unit
Select this check box when the Automatic Duplexing Unit is installed.

Drawers
This sets the installation of drawers according to the configuration.
- Drawer 1 — Select this when only Drawer 1 is installed.
- Drawer 1 & Drawer 2 — Select this when Drawers 1 and 2 are installed.
P.94 “Drawer Settings”
3) [Drawer Setting]
Sets the paper size and paper type of each drawer. The [Drawer Settings] dialog box appears by clicking
this.
P.94 “Drawer Settings”
4) [Version Information]
Displays the [Version Information] dialog box.
5) [SNMP Settings]
Click this button when you need to verify or change the SNMP settings.
P.95 “SNMP Settings”

In order to set [SNMP Settings], you must access the printer driver properties from the [Devices and
Printers] folder (Windows Vista / Windows Server 2008: [Printer]), but not from the [Print] dialog box in
the application.

6) [Enable SNMP Communication]
This enables SNMP communication between this equipment and your computer to retrieve the option

configuration information.

Update Automatically/Manual

Select whether to update option configuration information automatically each time the [Configuration] tab
of the printer driver is accessed or to update manually.

[Update Now]

This is available only when [Manual] is selected. Click this to obtain the configuration information from this
equipment immediately.

Drawer Settings

Drawer Settings @

1 Paper Size: Paper Type: 2

Drawer 1: Letter [B1/2 117 ~| [Pain -

Drawer 2 Lettzr (8142411 ~| [Pain -

Bypass Trap ‘Aulo '| | Flain - |

3 __: Restore Defaults |

Cancel

1) Paper Size
Select the paper size set in each drawer.
2) Paper Type
Select the paper type set in each drawer.
3) [Restore Defaults]
Restores the configuration of this equipment displayed in the [Configuration] tab menu to the original
factory defaults.
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SNMP Settings

SNMP Settings ===

1 ——————SHMPY1/2

Cormmutity Mame:

public

2 __[ Restare Default ] | 0K | | Cancel

1) SNMP V1/V2
Community Name — If a community name other than “private” (default) is set for the SNMP community
name for your TOSHIBA MFP, enter its community name.

* To find your TOSHIBA MFP under the SNMP V1/V2 environment, the community names set for the
target TOSHIBA MFP must be specified correctly. For help, consult your administrator.

¢ To change the community name, the administrator privilege is necessary. You must log in with the
“Administrator” privilege and open the printer driver properties.

¢ Up to 31 characters including the following symbols can be entered for the Community Name.
"#E % &' () +, -/ <=>2@[\]"_"{l}~

2) [Restore Defaults]
Click this button when you want to reset all the settings back to the defaults.
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Printing With Best Functions for Your Needs

In this section, procedures are given to print various types of print jobs, using the layout and finishing options.
Read this section before starting printing and select the procedure best suited for your needs.

P.96 “Layout and finishing options in [Basic] tab menu”

P.97 “Layout and finishing options in [Finishing] tab menu”

P.100 “Finishing options in [Effect] tab menu”

H Layout and finishing options in [Basic] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various
printing functions enabled with the [Basic] tab menu are explained.
P.96 “Fitting images within paper size”

Q Fitting images within paper size

Automatically enlarges or reduces an image to fit into a specified paper size, or manually set the scale to
enlarge or reduce it.

Printing enlarged or reduced image to fit the specified paper size

1 Display the [Basic] tab menu.

2 Select the document size on the [Original Paper Size] box. Then select the paper size
that you want to print at the [Print Paper Size] box.

Original Paper Size:

g Letter [B1/2 %117 w7
Frint Paper Size: 1anual Scale

: Legal (8142 214" - 100 =
N2
The document image is automatically enlarged or reduced depending on the original paper size and
print paper size.

3 Set any other print options and click [OK].
4 Click [OK] or [Print] to send the print job.

Printing an enlarged or reduced image by specifying the scale manually

1 Display the [Basic] tab menu.
2 Check the [Manual Scale] box. Then enter the scale.

Original Paper Size:

L;IJ Letter (81425117 -
| Manual Scale:
5 Same as Original Size B0 %([25-400]) 1

2

The scale can be set from 25% to 400% in units of 1%.
3 Set any other print options and click [OK].
4 Click [OK] or [Print] to send the print job.
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H Layout and finishing options in [Finishing] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various
printing functions enabled with the [Finishing] tab menu are explained.

P.97 “Sort printing”

P.98 “Printing on both sides of paper”

P.99 “Printing several pages on one sheet”

O Sort printing
Selects how multiple copies of a document to be output, such as separately for each copy and grouping each
page.

Sorting printed documents according to the copies

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

Mumber of Copies:

5 = [1-339)

3 Display the [Finishing] tab menu.
4 Select [Sort Copies] icon at [Copy Handling].

LCopy Handling:

) ) Ly

123 111 123

5 Set any other print options and click [OK].
6 Click [OK] or [Print] to send the print job.

Sorting printed documents according to the pages

For example, assume that you have a three-page job (A, B, C) and you want three copies of each page in this
order (AAA, BBB, CCC).

1 Display the [Basic] tab menu.
2 Enter the number of copies to be printed at the [Number of Copies] box.

Mumber of Copies:

5 - (1-399)

3 Display the [Finishing] tab menu.
4 Select [Group Copies] icon at [Copy Handling].

LCopy Handling

91y

1230111 123

5 Set any other print options and click [OK].
6 Click [OK] or [Print] to send the print job.
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Sorting printed documents horizontally and vertically for each copy

* Rotated Sort Copies can be enabled only when printing on Letter, A4, B5, or 16K.
* To make Rotated Sort Copies, sheets to be used must be placed both horizontally and vertically
(example: A4 and A4-R).

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

Mumber of Copies:
5 2 [1-939)

3 Display the [Finishing] tab menu.
4 Select [Rotated Sort] icon at [Copy Handling].

Lopy Handling

= &

123 1110123

5 Set any other print options you require and click [OK].

6 Click [OK] or [Print] to send the print job.
The printed documents are alternately sorted horizontally and vertically for each copy.

Q Printing on both sides of paper
You can print on both sides of paper.

Open the [Basic] tab to select the following settings.
* Any paper size other than envelopes from the [Print Paper Size] list. You cannot use envelopes.
* [Plain] from the [Paper Type] list. You cannot use other paper sizes.

2 Open the [Finishing] tab, select the [2-Side Printing] check box, and select the binding
position icon.

2-5ide Printing:
i)
Long Edge — Select this to print on both sides of the paper with a margin on the long edge.
Short Edge — Select this to print on both sides of the paper with a margin on the short edge.
3 Set other necessary print options and click [OK].

4 Click [OK] or [Print] to start the print job.

Tip
When the Automatic Duplexing Unit is not installed:
After all reverse sides of paper are printed, load the paper on the bypass tray printed face down, and press

[START] to print the front sides. If the message “This document failed to print” appears 30 seconds after
printing, turn over the paper and continue printing.
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U Printing several pages on one sheet

Prints several pages of a document on one sheet of paper (N-up feature). This feature is very useful for
browsing a large number of pages for appearance or page order.

For example, to check the navigation path of a number of web pages or review the narrative of a slide
presentation, using N-up is not only convenient but conserves paper as well.

Printing multiple pages per sheet n
1 Display the [Finishing] tab menu.

2 Select how many pages you want to print on a single sheet at the [Number of pages per
Sheet] box.

Dl =mEE Ry
N2

2 pages — Prints images from 2 pages arranged on one sheet.
4 pages — Prints images from 4 pages arranged on one sheet.
6 pages — Prints images from 6 pages arranged on one sheet.
8 pages — Prints images from 8 pages arranged on one sheet.
9 pages — Prints images from 9 pages arranged on one sheet.
16 pages — Prints images from 16 pages arranged on one sheet.

3 Select how the pages are arranged on one sheet in the [Direction of print] option.

Direction of Print:

4| s 4| o

Draw Borders AI% Pages

Left to Right — Arranges pages horizontally from the left and printed top to bottom on one sheet.
Right to Left — Arranges pages horizontally from the right and printed top to bottom on one sheet.
Left to Right by column — Arranges pages vertically from the top and printed left to right on one
sheet.

Right to Left by column — Arranges pages vertically from the top and printed right to left on one
sheet.

Tip

Items that can be selected in [Direction of print] may vary depending on the number of pages
selected at the [Number of pages per Sheet] box.

4 If you want to draw a line around each page, select the [Draw Borders Around Pages]
check box.

5 Set any other print options and click [OK].
6 Click [OK] or [Print] to send the print job.
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H Finishing options in [Effect] tab menu

Using the printer driver, you can set various layout options to suit your preferences. In this section various
printing functions enabled with the [Effect] tab menu are explained.
P.100 “Printing with watermarks”

O Printing with watermarks

Watermarks overprint your document with useful information, such as [TOP SECRET], [CONFIDENTIAL],
[DRAFT], [ORIGINAL], or [COPY]. You can choose from several predefined watermarks or you can create
and save your own custom watermarks.

Watermarks are text only.

Printing a watermark

1 Display the [Effect] tab menu.
2 Select the watermark to be printed at the [Watermark] box.

W atermark

TOF SECRET

DRAFT
ORIGIMAL 2
ReaEY

g

You can create a new watermark if there is none you want to apply on the box.
P.101 “Creating or editing a watermark”

3 If you want to print the watermark on only the first page, select the [Print on First Page
Only] check box.

‘W atermark.:
| [conrpENTIAL -|

| Agd. | | Edt. || Deete |
.r.im.t..!;!n..E.i.r.§.l...E!:.a.9§..Qn.|!.£

4 Set any other print options and click [OK].
5 Click [OK] or [Print] to send the print job.
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Creating or editing a watermark

1

N

o Oah~hWw

Click [Add] to create a new watermark, or select one that you want to edit and click
[Edit] to edit a watermark.

W atermark:

- |

Delete

Frint on Fi

The [Watermark] dialog box appears.

Watermark
Caption:
Classified

Font Mame:
i [ Avial ¥

Style:

| Regular - ‘
Font Size:
< 3

% 0 72 2 pE-a00)
I;‘josition Arale
0.00 * inch a
v a0 0 30

0.00 + inch Frint Style:
T Solid

Units:

o

@ inch m Draw as Dutline
@) Tiansparency
50 % 4 3

0 50 100

| Ceptie \Wateimark |

| Festore Defaults ‘

| Cancel

Enter the watermark text in the [Caption] box.

You can enter up to 63 characters for the [Caption] box. However, if too many characters are entered,
the watermark may not be printed correctly.

Select a font for the watermark at the [Font Name] box.
Select a font style for the watermark at the [Style] box.

Enter the font size in the [Font Size] box.
You can enter any integer between 6 and 300pt in units of 1pt.

To rotate the watermark, enter the number of degrees in the [Angle] box.

* You can enter from -90 degrees to 90 degrees in units of 1 degree in the [Angle] box.
* You can also set the angle using the scroll bar.

Select how the watermark text is printed from [Solid], [Draw as Outline], and
[Transparency].

Solid — Prints a solid type of watermark.

Draw as Outline — Prints an outline type of watermark.

Transparency — Prints a transparent watermark. Set the transparent ratio from 0 to 100% in units of
1%. You can also set the transparent ratio using the scroll bar.

Enter the X and Y values or move the scroll bar to adjust the watermark position.
* You can adjust the position horizontally with “X” and vertically with “Y”.

* You can select the unit, [inches] or [mm].

* Click [Center Watermark] to locate the watermark text to the middle horizontally and vertically.

Click [OK] to save the watermark settings.
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Deleting a watermark

You can delete the default watermarks. However, they cannot be restored by clicking [Restore Defaults].

1 Select the watermark that you want to delete at the [Watermark] box.

Wwatermark.:

[#] [Crassiie

| Agd. | [ Edt.

Frint on First Page Only

Click [Delete].
The [Confirm Delete] dialog box appears.

3 Click [Yes].

Confirm Delete 3

Are you sure you want to delete it?
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Scanning From Application

This equipment supports scanning from TWAIN-compatible applications. TWAIN is the standard that links
applications and scanners that acquire images. For TWAIN support, see your application’s manual.

Tip
You can make use of e-STUDIO Scan Editor bundled with the equipment. It helps you scan and edit

images. For the details, refer to the following page:
P.110 “Scanning from e-STUDIO Scan Editor”

Before you start scanning with this equipment, make sure that you have installed the scanner driver. For
details, refer to the Software Installation Guide.

The default original size depends on the measurement system on Windows: A4 for Metric or LT for the
North America. You can change the default only before the first execution after installation. For the
measurement system, see the Windows Help.

P.104 “How to scan”

Bl How to scan

Follow the steps below to scan the original. The following describes a general scanning operation that is
common to TWAIN-compatible applications.

1 Place the original(s).
P.33 “Placing originals on the original glass”
P.34 “Placing originals on the Reversing Automatic Document Feeder”

2 Run your TWAIN-compatible application and execute the image acquisition command.

You can usually execute the scan or image acquisition command on the [File] menu to select this
equipment. The location of the command and the method to select the scanner vary depending on the
application. See your application’s manual.

Set the scan settings.

* You can make various options to scan the original image.
P.106 “Scan options”

* You can also make the scan settings using the Easy Set feature.
P.108 “Using the Easy Set feature”
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Click [Pre-Scan] to preview the original.
If you are not satisfied with the preview image, change the scan settings and preview the image again.

Click [Scan] to scan the original.
While scanning, you can stop scanning by clicking [CANCEL].

When the authentication screen appears, enter the department code that is required to log in to this
equipment. For details, ask your administrator.

Save the scanned image in your application. n
The saving command varies depending on the application. You usually execute the Save or Save as  ~—
command on the File menu. If necessary, modify the scanned image, using the various graphic

commands in your application.

Scanning From Application 105



Setting up Scan Options

You can make various options to affect the scanning status. You can save different sets of options in files and
recall one of them for frequent use.

P.106 “Scan options”

P.108 “Using the Easy Set feature”

l Scan options

The basic and advanced dialogs are available for the scan operation.
P.106 “Basic scan dialog”
P.107 “Advanced scan dialog”

U Basic scan dialog

When you execute the image acquisition command, the following basic scan dialog appears.
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1) Easy Set
The scan options can be saved.
P.108 “Using the Easy Set feature”

2) ¥
Clears the preview image.
3) Preview screen

The pre-scanned image appears. The dotted boundary shows the scanning area or the original size. The
image information appears under the preview screen.

4) i

Shows the version information of the scanner driver.
5) |2

Shows the Help information about this scanner driver.

6) [Close]
Quits the scanning operation.

7) [Pre-Scan]
Pre-scans the original.

8) [Scan]
Scans the original.
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9) Measurement unit
Select [Inch], [mm], or [Pixel] to change the measurement unit.‘yoteihyou

10) o
Opens the advanced scan dialog.
P.107 “Advanced scan dialog”

0 Advanced scan dialog

You can click the triangle that faces right on the right-hand side of the basic scan dialog box to make scanning
settings. The default settings are underlined.
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1) Resolution
Sets the horizontal and vertical resolution as dots per inch: 150 x 150 dpi, 200 x 200 dpi, 300 x 300 dpi,
400 x 400 dpi, or 600 x 600 dpi.

2) Original Mode
Sets the original mode to fit the original image such as text only or the mixture of text and photos: Text,
Text/Photo, Gray, or Color.

3) Original Size
Sets the original document size or the scanning area.
Select the original size from the pull-down list.
The displayed items differ depending on the installed options and destinations.

Tips
* When [600 x 600 dpi] is selected in [Resolution] and [Color] is selected in [Original Mode], only [A5-
R] or [ST-R] can be selected.

* When [400 x 400 dpi] is selected in [Resolution] and [Color] is selected in [Original Mode], paper
size larger than [A4] or [LT] cannot be selected.

4) ADF/Platen
Selects the equipment on which the originals are placed: Platen Scan, ADF Scan, or Duplex Scan.
The displayed items differ depending on the installed options and destinations.

5) Rotation
Rotates the imaged clockwise by 90 degrees, counterclockwise by 90 degrees, or by 180 degrees. This
option takes effect on the image to scan but not on the preview image: OFF, Right 90, Left 90, or 180.
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6) |4

Closes the advanced scan dialog and return to the basic scan dialog.
P.106 “Basic scan dialog”

7) [Enhanced Settings] tab

- (% Exposure/Contrast

Adjusts the exposure and contrast of the image using the scroll bar or editing the field: -100 (lighter) to
100% (darker).

[Contrast] is only available when [Gray] or [Color] is selected in [Original Mode].

- &4 | Sharp
Adjusts the sharpness of the image using the scroll bar or editing the field: -2 (softer) to 3% (sharper).
[Sharp] is only available when [Gray] or [Color] is selected in [Original Mode].

- | lu | RGB Adjustment

Adjusts the RGB values of the image using the scroll bar or editing the field: -100 to 100%.
[RGB Adjustment] is only available when [Color] is selected in [Original Mode].

- |t Saturation

Adjusts the saturation of the image using the scroll bar or editing the field: -100 to 100%.
[Saturation] is only available when [Color] is selected in [Original Mode].

8) Default
Resets all the settings back to the defaults.

H Using the Easy Set feature

When you have made scan settings, you can save them as an Easy Set file. This allows you to load a specific
batch of settings without changing the scan settings each time.

P.108 “Saving the Easy Set file”

P.108 “Using the Easy Set file”

P.109 “Deleting the Easy Set files”

U Saving the Easy Set file

You can save multiple Easy Set files.

1 Open the advanced scan dialog from within your application.
P.104 “How to scan”

2 Set the scan options as you like.
P.106 “Scan options”

3 Click 5 next to the Easy Set menu.

4 Enter a file name, select a folder where you save the file, and then click [Save].

0 Using the Easy Set file

Select the pre-defined Easy Set file, or click = next to the Easy Set menu to select your
Easy Set file.

* The following two pre-defined files are available.

Pre-defined File Resolution Original Mode Other Scan Options
Picture 150 x 150dpi Text/Photo Default settings
Text 600 x 600 dpi Text

* When the Open dialog box appears, select the folder, select the target Easy Set file, and then click
[Open].

2 Click [Pre-Scan].
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U Deleting the Easy Set files

You can delete the Easy Set files in the same way as for normal files. Locate the folder where you have saved
the Easy Set file, right-click the file, and then click [Delete] from the menu. Click [Yes] to delete the file. When
you are working in the preview window, click the folder icon next to the Easy Set menu so that you can delete
the file in the same way. After deleting the file, click [CANCEL] to close the dialog box.
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4 SCAN FUNCTIONS

Scanning from e-STUDIO Scan Editor

e-STUDIO Scan Editor is an application to scan images with the equipment and edit them in Windows. From
this application, you can use the scanner driver to scan images. When you have followed the standard steps
to install the software such as a printer driver for the equipment, you also have installed this application. The
following describes the functions of e-STUDIO Scan Editor.

For details about a scanning procedure, refer to the following page.

3 P.104 “How to scan”

B Features of e-STUDIO Scan Editor

e-STUDIO Scan Editor has the following features:

* Scan an image and save it in a PDF, TIFF, or JPEG format.

* Scan two or more images and save them in a PDF or TIFF format.

* Insert images in a file window, which are saved in a JPEG, BMP, TIFF, PNG, or PDF format.

* Arrange the images in a file window.

* Edit images simply within the application or open another application to edit them.

* Open the e-mail application that is available as standard in Windows and attach an image file to an e-mail.

H Application window

You can start e-STUDIO Scan Editor from the [Start] menu of Windows. The following application window
opens and a file window shows thumbnails or scanned images. You can also insert image files from a folder
using a drag-and-drop operation. Select commands from the menu bar or click the icon on the tool bar to use
this application.

£ P.111 “Menu bar”

L P.113 “Tool bar”

= =]

File Edit Inset View Tools Window Help

> Odw S

Drop image files here

110 Scanning from e-STUDIO Scan Editor



O Menu bar

The following menus are available on the menu bar located at the top of the application window. You can
select commands from them.

P.111 “[File] menu”

P.112 “[Edit] menu”

P.112 “[Insert] menu”

P.112 “[View] menu”

P.112 “[Tools] menu”

P.112 “[Window] menu”

P.113 “[Help] menu”

. e-5TUDIO Scan Editor
File Edit Insert View Tools Window Help

[File] menu

You can select commands to handle files.

* New
Opens a new file window.

¢ Open
Opens files saved with this application or files saved in a JPEG, BMP, TIFF, PNG, or PDF format.

¢ Close
Closes the selected file window.

¢ Save
Saves a file. When you save a file first, you can name the file and save it in any folder. You can save a
single image in a PDF, TIFF, or JPEG format and two or more images in a PDF or TIFF format.

¢ Save As
Saves the selected file in another name. You can save a single image in a PDF, TIFF, or JPEG format and
two or more images in a PDF or TIFF format.

¢ Send
Opens the e-mail application that is available as standard in Windows and attaches the selected file to an
e-mail. You can select a format (TIFF or PDF) of the attached file on [Send] of the [Preferences] dialog box.
P.119 “Send”

¢ Print
Prints images in the selected file window.

¢ Select Scanner
Selects the scanner (TWAIN source/driver) of the equipment. When a dialog box opens, you can select a
TWAIN source in the list.

Tips

* The correct TWAIN source has been selected at the installation. In most cases, you do not need to
select the scanner again.

* If one or more TWAIN sources have been installed, be sure to select the correct TWAIN source for
the equipment.

* You can set preference for the TWAIN source on [Scanner] of the [Preferences] dialog box.
P.118 “Scanner”

¢ Acquire
Opens the scanner driver to scan images. The scanned images are shown as thumbnails in a file window.
P.106 “Setting up Scan Options”

* Exit
Quits this application.
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[Edit] menu

You can select common commands to handle images.

Undo

Undoes the last deleting operation.
Cut

Cuts the selected image.

Copy

Copy the selected image.

Paste

Pastes the cut or copied image at any position.
Delete Pages

Deletes the selected image.
Select All

Selects all images in a file window.

[Insert] menu

You can select commands to insert images in a file window.

Insert

Insert images after the selected image or the last one, which are saved in a JPEG, BMP, TIFF, PNG, or
PDF format.

Scanned Image

Scans images and inserts them after the selected image or the last one. You can scan images from the
scanner driver.

P.106 “Setting up Scan Options”

[View] menu

You can select commands to show or hide the tool bar and status bar.

Tool Bar

Shows or hides the tool bar at the top of the application window. You can turn on or off the tool bar by
clicking the command to attach or remove a check mark.

P.113 “Tool bar”

Status Bar

Shows or hides the status bar at the bottom of the application window. You can turn on or off the tool bar by
clicking the command to attach or remove a check mark.

[Tools] menu

You can select commands to open the dialog box where you can arrange images in a file window or you can
set the preferences for this application.

Arrange Pages

Opens the [Arrange Pages] dialog box to arrange the images in a file window.
P.116 “Arranging the images”

Preferences

Opens the [Preferences] dialog box to set the preferences for this application.
P.117 “Setting the preferences”

[Window] menu

You can arrange the file windows in the application window.

Cascade

Arranges the file windows by cascading them.
Vertical

Arranges the file windows vertically.

Horizontal

Arranges the file windows horizontally.

Close All

Closes all file windows.

Arrange Icons

Minimizes and arranges the icons of file windows.
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[Help] menu

You can select the commands show the help or information window of this application.
¢ Contents

Opens the help window of this application.
¢ About

Open the information window of this application.

U Tool bar

The following tool icons are available on the tool bar located under the menu bar at the top of the application
window.

Tip

You can show or hide the tool bar with [Too Bar] on the [View] menu.
P.112 “[View] menu”

< e-STUDIO Scan Editor
File Edit Insert View Teools Window Help

> " -

1 2 3 4 5 6 7 8

1) =» Acquire
Scans images. When you click this icon, the application starts scanning immediately or opens the scanner
driver. You can set the action on [Scanner] of the [Preferences] dialog box.
P.106 “Setting up Scan Options”
P.118 “Scanner”

2) New
Opens a new file window.

3) [ ” Open
Opens files saved with this application or files saved in a JPEG, BMP, TIFF, PNG, or PDF format.

4) | save

Saves a file. When you save a file first, you can name the file and save it in any folder. You can save a
single image in a PDF, TIFF, or JPEG format and two or more images in a PDF or TIFF format.

5) = Print

Prints images in the selected file window. When you click this icon, the application starts printing
immediately or opens the print dialog box. You can set the action on [Printing] of the [Preferences] dialog
box.

P.117 “Printing”

6) | Send

Attaches the selected file to an e-mail. You can select a format (TIFF or PDF) of the attached file on [Send]
of the [Preferences] dialog box.
P.119 “Send”

7) Preferences

Opens the [Preferences] dialog box to set the preferences for this application.
P.117 “Setting the preferences”
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8) =D Arrange Pages

Opens the [Arrange Pages] dialog box to arrange the images in a file window.
P.116 “Arranging the images”

H File window for the scanned images

A scanned image appears as a thumbnail in a file window. When two or more images are scanned, all of them
appear in a single file window. You can select a thumbnail and select commands from the shortcut menu, edit
images, and arrange them in the file window.

P.114 “Shortcut menu”

P.115 “Editing an image”

P.116 “Arranging the images”

Q Shortcut menu

When you right-click a thumbnail, the shortcut menu appears so that you can select the following commands

from the menu.

¢ Cut, Copy, Paste, Delete
Cuts, copies, and pastes an image. When you right-click a thumbnail and select [Cut] or [Copy] from the
menu, you can cut or copy the selected image, then you can select [Paste] to paste it at any position.
When you right-click a thumbnail and select [Delete] from the menu, you can delete the selected image.

¢ Insert File
Opens a dialog box so that you can select an image file to insert it in the current file window. You can insert
images saved in a JPEG, BMP, TIFF, PNG, or PDF format.

Tips

* You can move image files to insert them into a file window using a drag-and-drop operation.
* You can insert an image also by selecting [Insert] from the [Insert] menu on the menu bar.

¢ Insert Scanned Image
Scans images and insert them in the current file window. When you select [Insert Scanned Image], the
application starts scanning immediately or opens the scanner driver. You can set the action on [Scanner] of
the [Preferences] dialog box.
P.106 “Setting up Scan Options”
P.118 “Scanner”

Tip
You can scan and insert images also by selecting [Scanned Image] from the [Insert] menu on the menu
bar.
 ScartLpng® =)o ==

E " Cut
Copy

Paste
Delete
Insert File...

Insert Scanned Image...
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Q Editing an image

When you double-click a thumbnail, an edit window opens. You can edit the image using the following icons at
the bottom of the edit window. Click the [Previous Page] icon, the [Next Page] icon, or the Close button to
save the edited image.

| Scan02.png[Page 1 of 3] = e =

1) [K] Previous Page
Shows the previous image in a file window.

2) u Next Page
Shows the next image in a file window.

3) E Rotate 90 degrees Clockwise
Rotates an image by 90 degrees clockwise.

4) @ Rotate 90 degrees Anti-Clockwise
Rotate an image 90 degrees anticlockwise

5) |8 Tilt/ Skew

Tilts a skewed image. You can select the action to confirm the operation or to execute it without
confirmation on [Editor Options] of the [Preferences] dialog box.
P.120 “Editor Options”

6) B4 Flip

Flips an image upside down.

7) m Mirror

Inverts an image horizontally.
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8) [©Y Zoom In
Zooms in on an image.

9) @ Zoom Out
Zooms out from an image.

10) [ Fit to Width
Fits an image to the width of the window.

11) [£] Best Fit
Fits an image within the window.

12) [E§ Edit Page

Opens an image in another application to edit it. You can select the application on [Editor Options] of the
[Preferences] dialog box.
P.120 “Editor Options”

Tip

By default, you can open images in “Paint” that is a standard application of Windows.

13) [E{ Delete Page
Deletes the current image.

O Arranging the images

You can arrange images in two ways:
* Move a thumbnail to any position in a file window using a drag-and-drop operation.
* Select a file window and select [Arrange Pages] from the [Tools] menu. The [Arrange Pages] dialog box
appears so that you can arrange images as follows:
- Select an image and click [Move Up] to move it the previous position.
- Select an image and click [Move Down] to move it to the next position.
- Select an image and click [Delete] to delete it.
- Click [Reset] to cancel the operation you have done in this dialog box.
- Click [OK] to complete the above operation and close this dialog box.
- Click [Cancel] to cancel the above operation and close this dialog box.

Arrange Pages @

Move Up
=

3 Page: 3

116 Scanning from e-STUDIO Scan Editor



H Setting the preferences

You can set the preferences to use the basic functions of e-STUDIO Scan Editor. Select [Preferences] from
the [Tools] menu or click the [Preferences] icon on the too bar to open the [Preferences] dialog box. Click the
icons at the top of the dialog box to set the following functions.

P.117 “Printing”

P.118 “Scanner”
P.119 “Send”
P.120 “Editor Options”

Q Printing n

You can set the following print functions on [Printing].

Preferences @
A — -
| P
Printing

(versized Pages

How should pages that are too big for the paper be printed?

@ |gnore margins and then scale if necessary
Clip

Reduce to fit

Show dialog when “Print” Tool Bar Button is used.

ok | [ Cancel

* Oversized Pages
Selects one of the following options to print pages that are too big for the paper.
- Ignore margins and then scale if necessary
Ignores margins around an image and scale it to fit the paper if necessary.
- Clip
Clips an image to print on the paper.
- Reduce to fit
Reduces an image to print on the paper.
e Show dialog when "Print" Tool Bar Button is used.
Sets the action to be done when you click the [Print] icon on the tool bar. Select the check box to open the

print dialog box. Click to clear the check box to start printing immediately without opening the print dialog
box.
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O Scanner

You can set the following scan functions on [Scanner].

Preferences @
/ T -
Scanner

Current Scanner

e-STUDIOXXXXXSeries Scan Driver

Select..

Show dialog when “Scan” Tool Bar Button is used.

ok | [ Cancel

e Current Scanner
Shows the current scanner (TWAIN source/driver). When you click [Select], the dialog box opens so that
you can select any one source from the list.

Tips

* The correct TWAIN source has been selected at the installation. In most cases, you do not need to
select the scanner again.

* If one or more TWAIN sources have been installed, be sure to select the correct TWAIN source for
the equipment.

* You can select a TWAIN source also by selecting [Select Scanner] from the [File] menu.

¢ Show dialog when "Scan" Tool Bar Button is used.
Sets the action to be done when you click the [Acquire] icon on the tool bar or when you select [Insert
Scanned Image] from the shortcut (or context) menu. Select the check box to open the scanner driver.
Click to clear the check box to start scanning immediately without opening the scanner driver.
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O Send

You can set the following e-mail functions on [Send].

Preferences @

Send

Systemn used to =end image files

MAPI (Microsoft Outlook)

Attachment Format |T|FF - Tagged Image Format -

[ ok | [ Caneel

* System used to send image files
Shows an e-mail application. When you select [Send] from the [File] menu or click the [Send] icon on the
tool bar, you can attach a file to an e-mail and send it with the selected application.

Tip
The name of an e-mail application that has been set as a default program in Windows appears.

¢ Attachment Format
Selects a TIFF or PDF format of a file that you attach to an e-mail.
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0 Editor Options

You can set the following editor functions on [Editor Options].

Preferences @

Editor Options

Select the program you want to use for editing images.

Browse...

¥| Show confirmation when tiltiskew is done.

[ ok | [ camce |

* Select the program you want to use for editing images.
Shows an application to edit images. When you click [Browse], the dialog box opens so that you can select
an application that you use to edit images. You can type a path of the application directly in the field. When
you click the [Edit Page] icon in an edit window, you can open and edit the image within the selected
application.

¢ Show confirmation when tilt/skew is done.
Sets the action to be done when you click the [Tilt/Skew] icon in an edit window. Select the check box to
show a confirmation message before tilting or skewing an image. Click to clear the check box to tilt or skew
it immediately without confirmation.
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Scan to USB Memory

Scan to USB allows you to save scanned images as PDF, TIFF, or JPEG files in a USB storage device.

Scan to USB

USBMedia

M Procedure for Scan to USB Memory

USB storage devices must meet requirements below. However, some USB storage devices may not be
used with this equipment even though the requirements below are met.

- FAT16 or FAT32 format

- Single-partition (USB storage devices with multiple partitions are not supported.)

1 Place the original(s).

Tips

* For placing the originals, see the pages below.
P.33 “Copying originals”
* When an original is set on the Reversing Automatic Document Feeder (RADF) for scanning, its
size is automatically detected regardless of the settings specified in “ORIGINAL SIZE”.
* The following originals can be scanned.
- A/B format: A4, A3, A5-R, B5, B5-R, B4, A4-R and FOLIO*
- LT format: LT, LD, LT-R, LG, ST-R, COMP, 13"LG* and 8.5"SQ*
- Kformat: 8K, 16K and 16K-R
*: Only when original is set on original glass.

2 Press [SCAN].

COPY SCAN

Fi

OR
MC

DATA 1 [

Scan to USB Memory 121




3 To store scans in a USB storage device, connect the device to the equipment and wait a
few seconds.

5 Press >, and then make the scan settings as required.

& DocYYMMDD
Eleor

Tip

The settings available for Scan to USB Memory are as follows:

Menu Functions Settings Description
FILE - An initial file name can be
NAME(MAX128) changed.

P.129 “Character entry”
FILE FORMAT PDF MULTI Stores your scan as a PDF file.
SINGLE Select [MULT]I] for saving several

pages as a single file.

Select [SINGLE] for saving
several pages as a separated
single file for each page.

TIFF MULTI Stores your scan as a TIFF file.
SINGLE Select [MULT]I] for saving several
pages as a single file.

Select [SINGLE] for saving
several pages as a separated
single file for each page.

JPEG Stores your scan as a JPEG file.
This setting is not available when
“BLACK” is selected in the
“COLOR MODE” function.

To make further settings, see the following.
P.137 “Scan Menu List”
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6 Press [START].

When you store scans in a USB storage device, never attempt to remove the device from the
equipment until data transmission is completed. Removing the USB storage device during data
transmission may corrupt the device.

If there are more originals, place the next ones.

* When you place originals on the Reversing Automatic Document Feeder (RADF), select “SCAN
NEXT” using V/ or A and press [OK]. (Only when “CONTINUE SCAN” is set to “ON”)

* When you place an original on the original glass, select “SCAN NEXT PAGE” using V or A and
press [OK].

RADF Original Glass

NEXT ORIGINAL?

CONTINUE SCAN

FINISHED

FINISHED

Tip
Repeat step 7 until all the originals have finished being scanned.

If there are no more originals, select “FINISHED” using V or A. The originals are stored
by pressing the [OK].

If originals remain on the Reversing Automatic Document Feeder after pressing [FINISHED] on the
CONTINUE SCAN screen, remove all the originals. Leaving them may cause a paper jam.
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Scan Settings

You can make the scan settings on the scan functions menu.

Tip

Press [CANCEL] to exit from the setting without making any changes. You can also exit by pressing <l if it
is active.

H Selecting the color mode

You can select the color mode best suited to your scan job.

53 SELECT SCAN TYPE
Ll use -
300dpi -
Menu Functions Settings Description
COLOR MODE BLACK Images in black and white.
GRAY SCALE Images containing both text and photos. The photo
quality is enhanced.
FULL COLOR Color images.

1 Press [SCAN].
2 Press V or A to select the item displayed on the LCD screen, and then press .

3 Press V or A to select the setting item, and then press [OK].

H Selecting the resolution

You can select the resolution.

=1 SELECT SCAN TYPE
Ll uss -
BLACK
300dpi b
Menu Functions Settings
RESOLUTION 600dpi*!
400dpi2
300dpi
200dpi
150dpi

*1  When the “FULL COLOR” mode has been selected, you can select “600 dpi” only for the original of A5-R or ST-R size.
*2 When the “FULL COLOR” mode has been selected, you cannot select the original size larger than A4 or LT.

1 Press [SCAN].
2 Press V or A to select the item displayed on the LCD screen, and then press >.

3 Press V or A to select the setting item, and then press [OK].
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H Scanning the 2-sided originals

With the single/2-sided scan setting, you can choose whether to scan your originals on both sides.

To scan 2-sided originals automatically, the Reversing Automatic Document Feeder is required.

=3 SELECT SCAN TYPE
BLACK -
300dpi
SINGLE »hd
Menu Functions Settings Description
SINGLE/2-SIDED SINGLE Scans only the front of the originals.
SCAN DUPLEX Scans both sides of the originals.

1 Press [SCAN].
2 Press V or A to select the item displayed on the LCD screen, and then press .

3 Press V or A to select the setting item, and then press [OK].

M Selecting the original size

You can specify the original size.

=1 SELECT SCAN TYPE
300dpi -
SINGLE
A3 >hd
Menu Functions Settings Description

ORIGINAL SIZE A4, LT, LD, B5, A3, A5-R, Sets the size of your originals.
B4, A4-R, B5-R, LT-R, LG,
ST-R, FOLIO, COMPUTER,
13”LG, 8.5”SQ, 8K, 16K,
16K-R

1 Press [SCAN].
2 Press V or A to select the item displayed on the LCD screen, and then press [>.
3 Press V or A to select the setting item, and then press [OK].

Tip

When an original is set on the Reversing Automatic Document Feeder (RADF) for scanning, its size is
automatically detected regardless of the settings specified in “ORIGINAL SIZE”.
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H Scanning different sizes in one go

When different sizes of originals are mixed and placed on the Reversing Automatic Document Feeder, some
combinations of sizes can be scanned in one go.
The combination of the original sizes that can be mixed are as follows:

Other than North America: A3 and A4 or B4 and B5

North America: LD and LT or LG and LT-R

=1 SELECT SCAN TYPE
SINGLE -~
AUTO SIZES
Menu Functions Settings
MIXED SIZE OFF
ORIGINAL ON

1 Press [SCAN].
2 Press V or A to select the item displayed on the LCD screen, and then press [>.
3 Press V or A to select the setting item, and then press [OK].

H Selecting the original mode

You can select the original mode for the image quality best suited to your originals.

£53 SELECT SCAN TYPE
SINGLE -
A3
TEXT >
Menu Functions Settings Description
ORIGINAL MODE | TEXT Text and photographs mixed.
TEXT/PHOTO Scans in the appropriate image quality for the
original(s) with text, fine illustration and watermark.
PHOTO Photographs only.

1 Press [SCAN].
2 Press V or A to select the item displayed on the LCD screen, and then press [>.

3 Press V or A to select the setting item, and then press [OK].
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H Selecting the orientation

You can change the orientation of your scans. Select the desired rotation pattern.

=3 SELECT SCAN TYPE

A3 -~
TEXT
2] [2] >
Menu Functions Settings Description
ROTATION [A]=[A] Scans originals without a change in orientation.
[1]= Rotates your scans 90 degrees to the right.

1 Press [SCAN].

2 Press V or A to select the item displayed on the LCD screen, and then press >.

3 Press V or A to select the setting item, and then press [OK].

H Selecting the compression ratio

You can select the compression ratio for the scanned image data. In general, the higher the compression
ratio, the lower the image quality.

=1 SELECT SCAN TYPE

TEXT -
2]+ [2]
COMPRESS : LOW > g

This function is not available when “BLACK” is selected in the “COLOR MODE” function.

Menu Functions

COMPRESS

Settings Description
Low Applies a low compression ratio and enhances the
image quality.
MID Compresses the data with a moderate compression
ratio and obtains an average image quality.
HIGH For a high compression ratio. Suitable when you

want to minimize the data size rather than enhance
the image quality.

1 Press [SCAN].

2 Press V or A to select the item displayed on the LCD screen, and then press >.

3 Press V or A to select the setting item, and then press [OK].
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Hl Removing blank pages

If your original contains blank pages, you can remove them from the scan result.

5 SELECT SCAN TYPE
[£] =+ [A] -
COMPRESS : LOW

OMIT BLANK:OFF >

This function is available only when “BLACK” is selected in the “COLOR MODE” function.

Menu Functions Settings
OMIT BLANK OFF
PAGE ON

1 Press [SCAN].
2 Press V or A to select the item displayed on the LCD screen, and then press >.
3 Press V or A to select the setting item, and then press [OK].

M Adjusting the exposure

You can adjust the density to make scans lighter or darker in nine levels from -4 to +4. The auto density
setting can represent the scan image in the middle density status.

* This function is available only when “GRAY SCALE” is selected in the “COLOR MODE” function.
* “AUTO” is available only when “BLACK” is selected in the “COLOR MODE” function and “TEXT” or
“TEXT/PHOTO” is selected in the “ORIGINAL MODE” function.

=5 SELECT SCAN TYPE

COMPRESS : LOW -~
OMIT BLANK:OFF

AUTO EXPOSURE 4~
Menu Functions Settings Description
EXPOSURE AUTO Adjusts the density automatically.
Manual Adjusts the density manually.

Press [SCAN].
Press V or A to select the item displayed on the LCD screen, and then press >>.

Press V or A to select the setting item.

2ON =

Adjust the density as follows.

For “AUTO”:

Press [OK].

For manual:

1) Press > or <|to increase or decrease the density level.
2) Press [OK].
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H Continuing the scanning

When you scan with the Reversing Automatic Document Feeder (RADF), you can select whether you
continue scanning the next originals after the last loaded original is scanned.

£ SELECT SCAN TYPE

OMIT BLANK:OFF -~
AUTO EXPOSURE

CONTINUE SCAN:ON DPhd

Menu Functions Settings
CONTINUE SCAN | OFF
ON

1 Press [SCAN].
2 Press V or A to select the item displayed on the LCD screen, and then press >.

3 Press V or A to select the setting item, and then press [OK].

H Character entry

The character entry screen is for entering characters when you are setting and entering items.
You can enter the following:
Alphabet characters, numbers and symbols.

Enter the characters using the digital keys and A, V, >, or <], after switching the type of the character with the
[*] digital key.

QO Switching the input mode

The type of the character is displayed in the first line of the message display panel. Set the type of character
to enter by pressing the [%] digital key.
The input mode switches as follows each time the [%] key is pressed.

Alphabet characters <--> Numbers

O Entering characters
Example: To enter “Chicago”

1 Press [%] to set the alphabet input mode.

FILE NAME (MAX128)

=T=]
o :Aa

2 Press [2] a few times to enter “C”.

FILE NAME (MAX128)

C

o
>
Q
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3 Press > to move the cursor to the right.

FILE NAME (MAX128)

c_

=T
ot Aa

Tip
If you want to enter the character assigned to another digital key, you can enter it without moving the
cursor to the right or pressing >.

4 Similarly, you can enter the following characters using the digital keys.

FILE NAME (MAX128)

Chicago

=T
an i Aa

5 After you have entered the last character, Press [OK].
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U Relationship between the digital keys and the input character
The character entered by each digital key differs depending on the input mode. The assignment of characters
in the character input mode is as follows.

Characters entered in the character input mode

You can enter the characters displayed on the upper side of the digital keys.

Digital key Number of times the key is pressed (—)
1 . @ 1
2 A B C 2 a b c
3 D E F 3 d e f
4 G H I 4 g h i
5 J K L 5 i k I
6 M N @) 6 m n 0
7 P Q R S 7 p q r s
8 T U V 8 t u \Y
9 w X Y z 9 w X y z
0 0
# <space> - +

l Scan speed

The scan speed depends on the selected color mode and resolution settings.
The approximate scan speed (for A4 / LT) at each color mode and resolution using the TWAIN driver is listed
in the table below.

Color Mode Resolution Scan Speed
Black 150 dpi
200 dpi
300 dpi 25 pages/minute
400 dpi
600 dpi
Full Color 150 dpi )
- 24 pages/minute
200 dpi
300 dpi 18 pages/minute
400 dpi 7 pages/minute”
600 dpi 7 pages/minute”2

*1 Available only A4/LT or smaller size
*2 Available only A5-R/ST-R

The color mode and resolution settings can be changed on the scan setting screen. For details, see the
following sections:

P.124 “Selecting the color mode”

P.124 “Selecting the resolution”
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Using Templates (Scan)

Once you have set the several functions and settings, you can register up to three of them as “templates” and
recall one of them for frequent use.
H Registering the templates

1 Make settings for the functions to register as a template.
2 Press [TEMPLATE].

SETTINGS TEMPLATE ENERGY SAVER

o O

FUNCTION CLEAR
./@ ABC DEF FC
C1)HC2)(3)
il it M CLEAR/STOP
4 5 6 ( z
( PQRS> ( TUV ) ( ) C/©

<A7“2>< 8 )(W;YZ> START
GO®® (o))

3 Press V or A to select “REGISTRATION”, and then press >.

TEMPLATE

RECALL

REGISTRATION 4

4 Press V or A to select a template, and then press [OK].

* You can register three templates for scanning.

* The settings are overwritten if you select an existing template.

* Update the recipients of the template if you have updated the address book.

* You can also register and edit templates with TopAccess. For details, refer to the TopAccess Guide.

You can specify the following items in scan templates.

Basic setting

No. Item Name Settings

1 Scan to (Agend) USB

2 Color Mode BLACK, GRAY SCALE, FULL COLOR

3 Resolution 150dpi, 200dpi, 300dpi, 400dpi*!, 600dpi*2

4 Single/2-Sided Scan SINGLE, DUPLEX

5 Original Size A4, LT, LD, B5, A3, A5-R, B4, A4-R, B5-R, LT-R, LG, ST-R,
FOLIO, COMPUTER, 13’LG, 8.5”SQ, 8K, 16K, 16K-R

6 Mixed Original Size OFF, ON

7 Rotation [A] = [A] [z]-+[A]

8 Compress LOW, MID, HIGH

9 Omit Blank Page OFF, ON

10 | Exposure AUTO, MANUAL(4)

11 | Continue Scan™ OFF, ON

*1 When the “FULL COLOR” mode has been selected, you cannot select the original size larger than A4 or LT.
*2 When the “FULL COLOR” mode has been selected, you can select “600 dpi” only for the original of A5-R or ST-R size.
*3 This item is available only when the Reversing Automatic Document Feeder (RADF) is installed.
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Scan to USB

No. Item Name Settings
1 File Format PDF(SINGLE), PDF(MULTI), TIFF(SINGLE), TIFF(MULT]I),
JPEG
2 File Name The default value or the file name entered from the control
panel.
H Recalling a template

1 Press [TEMPLATE].
2 Press V or A to select “RECALL”, and then press .

TEMPLATE

REGISTRATION

3 Press V or A to select a template, and then press [OK].

Using Templates (Scan)

133






VARIOUS FUNCTIONS

Lo o 3V 1 U= o 10 T N 136
(7o) o)V 21T U1 (=10 S TP PP PP P PP OPRPPPPRPIN 136
T o= 1 T oY o T T N 137
Yoz ol 0 a1 o TU I =Y 101 PP PTURPT 137
NetWOrk Menu LiSt ......coeueiiiiiiiiiriceccsss s s rr s s s s s s s s e s s s s s s e e e e s rmmm s nns s e e e e e nmnmnnsssnssnnenns 139
I O] = (0 1= PP E PR UORPN 139
Setting the Ethernet SPEEa........coo i et e e e 139
Setting the TCP/IP ProtOCOI......cco ettt e et e et e e st e e et e e e neeeesneeeanteeeeseeeaneeeenseeennns 140
Setting the HTTP NEIWOIK SEIVICE ........ueiiiiiieiie ettt e et e e e et e e e e e e e e s st a e e e e s ennsaaeaaean 141
User Functions Menu List ... rrrrrrecsss s e s s e s s s s s s e e s e e mmma s s s e e e e 142
USEr FUNCHIONS MENU IEEIMS ...ttt e e et e e e et e e e e e e bsaeeaeesssasaeeeeesnssaesansbaseaessanssneaesannns 143
Department Management ... ———— 150
JOD STAtUS ... e e e e e e e e e nnannaaereaeraraes 152

JOB STATUS MENU HEEIMS ...vvvveieeieiieieeeee e e e e ettt e e e e e eeeeeeeeeeeeeaeea s e ssssbabesssneeeeseeaeaeesesesasessssnnneneneeeeees 152



Copy Menu List

See the following page for information on using the copy menu.
P.31 “COPY FUNCTIONS”

Hl Copy menu items

When you press V or A on the main screen (Copy), you enter the copy menu which allows you to use copy
functions.
The table below shows the functions and reference pages available in the copy menu.

Menu Functions Settings Description and Reference Pages

EXPOSURE AUTO, Manual Sets the density level for the copied image.
P.39 “Adjusting the exposure”

ORIGINAL MODE | TEXT/PHOTO, TEXT, PHOTO, Sets an original mode suitable for the
BACKGROUND ERASE image being copied.
P.40 “Selecting the original mode”

DRAWER Drawer 1 XX to Drawer 2 XX, Bypass Sets the paper source.
XX, APS P.41 “Selecting the paper”

ZOOM Manual zoom (25 - 100 - 400%), FIXED | Sets the zoom ratio for copied images.
ZOOM, AMS P.43 “Enlarging or reducing the copy
size”

FINISHING NON SORT, SORT, ROTATE SORT Sets the finishing mode for ejecting copies.
P.48 “Sorting pages”

2IN1/4IN1 OFF, 2IN1, 4IN1 Copies two or four originals onto one sheet
of paper.

P.50 “Copying two or four pages on
each sheet”

ID CARD OFF, ON Sets the ID card function.
P.52 “Copying both sides of a card on a
sheet”

EDGE ERASE OFF, ON (4 - 15mm) Sets the edge erase function.
P.54 “Erasing the shadow on edges”

DUAL PAGE OFF, ON Sets the dual page function.
P.55 “Copying right and left pages
separately”

IMAGE SHIFT OFF, LEFT MARGIN, RIGHT MARGIN Sets the image shift function.
P.56 “Shifting the pages to the right or
left”

2-SIDED 1>1SIMPLEX, 1> | BOOK, TABLET Sets the 2-sided function.

2 DUPLEX, 2> 2 P.57 “Copying on one or both sides”
DUPLEX, 2 > 1
SPLIT

ANNOTATION OFF, PAGE NO., PAGE No.+DATE/TIME | Sets the annotation function.
P.60 “Adding a page number on the
copied paper”

OMIT BLANK OFF, ON Sets the omit blank page function.
PAGE P.61 “Removing blank pages”

MIXED SIZE OFF, ON Sets the mix-original function.
ORIGINAL P.62 “Copying different sizes in one go”

IMAGE OFF, ON Sets the image direction function.
DIRECTION P.63 “Image direction”

CONTINUE SCAN | OFF, ON Sets the scan continuation function.
P.64 “Continuing the scanning for a

copy”
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Scan Menu List

See the following page for information on using the scan menu.
P.103 “SCAN FUNCTIONS”

Bl Scan menu items

When you press V or A on the main screen (Scan), you enter the scan menu which allows you to use basic
and advanced scan functions.
The table below shows the functions and reference pages available in the scan menu.

Menu Functions Reference Pages
USB FILE NAME(MAX128) P.137 “USB functions”

FILE FORMAT
COLOR MODE P.138 “Basic setting functions”
RESOLUTION
SINGLE/2-SIDED SCAN
ORIGINAL SIZE

MIXED SIZE ORIGINAL
ORIGINAL MODE
ROTATION
COMPRESS

OMIT BLANK PAGE
EXPOSURE
CONTINUE SCAN

0 USB functions
The following functions and settings are available on the USB functions menu.

Menu Functions Settings Description and Reference Pages
FILE You can use up to 128 characters. Enter the file name to save.
NAME(MAX128) P.121 “Procedure for Scan to USB

Memory”
P.129 “Character entry”
FILE FORMAT PDF MULTI Sets the file format to attach the scanned
SINGLE data to the E-mail.
P.121 “Procedure for Scan to USB
TIFF MULTI Memory”
SINGLE
JPEG
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U Basic setting functions

The following functions and settings are available on the basic setting functions menu.

Menu Functions

Settings

Description and Reference Pages

150dpi

COLOR MODE BLACK, GRAY SCALE, FULL COLOR | Sets the color mode to scan the data.
P.124 “Selecting the color mode”
RESOLUTION 600dpi*!, 400dpi*“2, 300dpi, 200dpi, Sets the resolution for the data to scan.

P.124 “Selecting the resolution”

SINGLE/2-SIDED
SCAN

SINGLE, DUPLEX

Sets the type of originals to scan.
P.125 “Scanning the 2-sided originals”

ORIGINAL SIZE A4, LT, LD, B5, A3, A5-R, B4, A4-R, Sets the size for the original to scan.
B5-R, LT-R, LG, ST-R, FOLIO, COMP, P.125 “Selecting the original size”
13”LG, 8.58Q, 8K, 16K, 16K-R

MIXED SIZE OFF, ON Sets the mix-original function.

ORIGINAL P.126 “Scanning different sizes in one

go”

ORIGINAL MODE

TEXT, TEXT/PHOTO, PHOTO

Sets the type of the original to scan.
P.126 “Selecting the original mode”

ROTATION

2]+ A, (] -+ [2]

Rotates the scanned data to save.
P.127 “Selecting the orientation”

COMPRESS

LOW, MID, HIGH

Sets the compression ratio for the scanned
image data.
P.127 “Selecting the compression ratio”

OMIT BLANK PAGE

OFF, ON

Sets whether to remove blank pages from
the scan result.
P.128 “Removing blank pages”

EXPOSURE

AUTO, Manual

Sets the density level for the scanned
image data.
P.128 “Adjusting the exposure”

CONTINUE SCAN

OFF, ON

Sets the scan continuation function.
P.129 “Continuing the scanning”

*1 When the “FULL COLOR” mode has been selected, you can select “600 dpi”

only for the original of A5-R or ST-R size.

*2 When the “FULL COLOR” mode has been selected, you cannot select the original size larger than A4 or LT.
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Network Menu List

You can set various network functions.

Tip

For instructions on how to display the NETWORK menu, see the following page:

P.142 “User Functions Menu List”

NETWORK

NIC STATUS
ETHERNET h

P.139 “NIC status”

P.139 “Setting the Ethernet speed”

P.140 “Setting the TCP/IP protoc

ol”

P.141 “Setting the HTTP network service”

Once the network has been set up, exit from USER FUNCTIONS menu by pressing [CANCEL] or [USER
FUNCTIONS] button. When “APPLY AND REBOOT?” message appears, select “YES”, and then press
[OK]. The equipment is automatically rebooted and the network settings are applied.

B NIC status

You can confirm the current network communication status.

NIC STATUS

LINK:CONNECTED -~

H Setting the Ethernet speed

You can specify the Ethernet speed.

ETHERNET

10MBPS HALF DUPLEX
10MBPS FULL DUPLEX ¥

Item name

Description

AUTO

10MBPS HALF DUPLEX
10MBPS FULL DUPLEX
100MBPS HALF DUPLEX
100MBPS FULL DUPLEX

Select the desired combination of communication speed and

transmission method.

If the network is not stable, turn the power of the equipment OFF and then back ON.
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H Setting the TCP/IP protocol

You can set the TCP/IP protocol that is commonly used in most network systems. When using Web-based
utilities such as TopAccess or network features of this equipment such as network printing and network
scanning, you are required to set the TCP/IP protocol.

In the TCP/IP setting operation, you can select the addressing mode, as well as assign the IP address, subnet
mask and default gateway (when manually assigned).

How the TCP/IP protocol must be set depends on your network environment.

TCP/IP

ADDRESS MODE

IP ADDRESS
SUBNET MASK hd

Item name Description

ADDRESS MODE » STATIC IP (When connecting to a local area network using static IP addresses)
Select [STATIC IP] and specify an IP address when connecting to a local area
network where static IP addresses are used. Also set the subnet mask and
default gateway as required.

* DYNAMIC (When TCP/IP is set by Auto-IP addressing or DHCP server)

Select [DYNAMIC] when you do not know the TCP/IP settings that should be
assigned to the equipment. If [ DYNAMIC] is selected when your network supports
the DHCP, the IP address, subnet mask, default gateway, primary WINS server
address, secondary WINS server address, POP3 server address, and SMTP
server address are acquired from the DHCP server. If the DHCP is not supported,
an appropriate |IP address is assigned to this equipment by the auto-IP
addressing function. However, the auto-IP addressing may not work properly if a
router is placed in the network.

* NO AUTO IP (When TCP/IP is set using only the DHCP server)

Select [NO AUTO IP] when the equipment is connected to a local area network
with a DHCP server and you want to set the TCP/IP not using the auto-IP
addressing function, but only the DHCP. When [NO AUTO IP] is selected, the IP
address, subnet mask, default gateway, primary WINS server address, secondary
WINS server address, POP3 server address, and SMTP server address are
acquired from the DHCP server, and the IP address assignment by the auto-IP
addressing function disabled.

IP ADDRESS Press [IP ADDRESS] and enter the IP address of this equipment using the digital
SUBNET MASK keys.

DEFAULT Enter the subnet mask and default gateway as required.

GATEWAY Use A or V to switch the active box.

This item is enabled only when [STATIC IP] is selected for [ADDRESS MODE].

Use the digital keys to enter [IP ADDRESS] or [SUBNET MASK] or [DEFAULT GATEWAY].
For entering characters, see the following page.
P.129 “Character entry”
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H Setting the HTTP network service

You can enable or disable the HTTP network server service that provides web-based utilities on this
equipment, such as TopAccess.

HTTP

PRIMARY PORT NUMBER

Item name Description
HTTP SERVER * ENABLE — Press this button to use the HTTP network server
service.
* DISABLE — Press this button to disable the HTTP network server
service.
This option must be enabled for TopAccess.
PRIMARY PORT NUMBER Press this button to enter the primary port number to be used for
receiving HTTP access from other clients. Normally use the default port
number “80”.

Use the digital keys to enter [PRIMARY PORT NUMBER].
For entering characters, see the following page.
P.129 “Character entry”
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User Functions Menu List

Before you start operating the “USER FUNCTIONS” menu, learn the general procedure below.

Tips

* Press [CANCEL] to exit from the setting without making any changes. You can also exit with the <l
button if it is active.

* Press [CLEAR/STOP] to delete a character. Keep pressing [CLEAR/STOP] for a second to clear all
characters.

1 Press [USER FUNCTIONS].

USER
FUNCTIONS JOB STATUS  SETTINGS

/@
|
ORIGINAL @
MODE @ EXPOSURE m
<l ‘
@ PQRS
|
O Aa/12
|
CANCEL OK

2 Press V or A to scroll the menu, and then press > to enter the function menu.
P.143 “User functions menu items”

USER FUNCTIONS

3 Press V or A to scroll the menu, and then press > to select the function.

4 Press V or A to scroll the menu, and then press > to select the settings for each
function.

Press V, A, >, or < to select a setting, and then press [OK].

» Continues to the next step if the selected setting has more options or values.

» Exits from the menu if the selected setting has no more options or values. At this point, the operation
is complete.

6 Make option settings with V, A, >, or <, or enter characters using the digital keys, and
then press [OK].
* Repeat this step if the selected setting has more options or values.
* Exits from the menu if the selected setting has no more options or values. At this point, the operation
is complete.

Tip
The options or values vary depending on the function.
P.144 “GENERAL”
P.147 “COPY”
P.148 “SCAN”
P.148 “USB PRINT”
P.149 “LIST”
P.149 “DRAWER”
P.149 “INFORMATION”
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B User functions menu items

When you press [USER FUNCTIONS] on the main screen (Copy), you enter the “USER FUNCTIONS” menu
which enables you to change each setting and execute the device functions.
The table below shows the functions and reference pages available in the “USER FUNCTIONS” menu.

Menu Functions

Reference Pages

MANUAL LEVEL

ORIGINAL MODE

MAXIMUM COPIES

SORT MODE PRIORITY

AUTO 2-SIDED MODE

2IN1/4IN1

ORIGINAL SIZE

ORIG. ORIENTATION

PAGE LAYOUT

BACKGROUND

SHARPNESS

OMIT BLANK PAGE

CONTINUE SCAN

GENERAL CHANGE LANGUAGE P.144 “GENERAL"
CLOCK DATE/TIME
DATE FORMAT
WALKUP SCREEN
TIMERS AUTO POWER SAVE
SLEEP MODE
AUTO CLEAR
WEEKLY TIMER
DEPARTMENT CODE
POP UP DRAWER SET
PAPER JAM RECOVERY
LCD CONTRAST
NETWORK COMPLETE
NIC STATUS
ETHERNET
TCP/IP
HTTP
COPY EXPOSURE P.147 “COPY"
EXPOSURE LEVEL AUTO LEVEL

User Functions Menu List
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Menu Functions

Reference Pages

SCAN COLOR MODE P.148 “SCAN"

COMPRESS

2-SIDED SCAN

ROTATION

BLACK SETTING RESOLUTION
ORIGINAL MODE
EXPOSURE

GRAY SETTING RESOLUTION

FULL COLOR SETTING | RESOLUTION
ORIGINAL MODE

OMIT BLANK PAGE

CONTINUE SCAN

USB PRINT PAPER SIZE A3, A4, B4, B5, A5-R, P.148 “USB PRINT"

FOLIO, LD, LG, LT, COMP,
13"LG, ST-R, 8.55Q

2-SIDED SINGLE, DUPLEX

LIST DEPARTMENT P.149 “LIST"
DRAWER DRAWER 1 P.149 “DRAWER"
DRAWER 2
INFORMATION COUNTER TOTAL COUNTER P.149 “INFORMATION"
TONER REMAIN
SERIAL NUMBER
U GENERAL

The following functions and settings are available on the “GENERAL” menu.

Menu Functions

Settings

Description

CHANGE LANGUAGE

S-CHINESE (SIMPLIFIED
CHINESE), T-CHINESE
(TRADITIONAL CHINESE),
JAPANESE, ENGLISH,
FRENCH, ITALIAN,
GERMAN, POLISH,
RUSSIAN, SPANISH,
SWEDISH, NORWEGIAN,
FINNISH, DANISH, DUTCH,
PORTUGUESE, CZECH,
HUNGARIAN, ROMANIAN,
SLOVAKIAN, LITHUANIAN,
IRISH, SLOVENIAN,
BULGARIAN, LATVIAN,
SERBIAN, TURKISH

Sets the default language. The
default language and the
appearance order vary
depending on the region.

CLOCK

DATE/TIME YYYY/MM/DD/HH/MM
Year:00~99
Month:01~12
Day:01~28, 29, 30, 31
Hour:00~23
Minute:00~59

Sets the date and time.

DATE FORMAT MM/DD/YY
DD/MM/YY
YY/MM/DD

Sets the data format
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Menu Functions

Settings

Description

WALKUP SCREEN

COPY, SCAN

Sets the start screen.

TIMERS

AUTO POWER SAVE

1,3,4,5,7,10, 15, 20, 30, 45,
60

Sets the period of time (in
minutes) that this equipment
should wait before low power
mode is activated.

SLEEP MODE

1,3, 5,10, 15, 20, 25, 30, 40,
50, 60

Sets the period of time (in
minutes) that this equipment
should wait before sleep mode
is activated.

AUTO CLEAR

15, 30, 45, 60, 75, 90, 105,
120, 135, 150

Sets the time (in seconds) to
clear the previous settings and
return to the main screen.

WEEKLY TIMER

OFF, ON (SUNDAY,
MONDAY, TUESDAY,
WEDNESDAY, THURSDAY,
FRIDAY, SATURDAY)

Sets the time to enter energy
saving mode and the time to
exit the energy saving mode for
each day from Sunday to
Saturday.

DEPARTMENT
CODE

YES

MASTER
CODE/
DEPARTMENT
CODE

NUMBER (01 to 99)

Sets the department number in
the range from "2" to "99". ("01"
is already registered as the
master code (administrator's
code).)

NAME (max 20 characters)

Enter the department name.
P.129 “Character entry”

CODE (5 digits)

Sets the 5-digit number for
master code or department
code. Entered numbers are
displayed as asterisks (*).
Existing codes cannot be
entered.

Do not forget this 5-digit
number for master code
because it is required for
setting or deleting each
department code.

NO

Department code is not set.

POP UP

DRAWER SET

ENABLE, DISABLE

PAPER JAM
RECOVERY

ENABLE, DISABLE

Sets whether to display a pop-
up message on the LCD screen
in the following cases.

* When the size of paper
loaded in the drawer differs
from setting.

* When a paper misfeed
occurs.

LCD CONTRAST

-3 (Light) to +3 (Dark)

Sets the brightness of LCD
panel.
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NETWORK

Menu Functions Settings Description
COMPLETE - Completes the network settings.
NIC STATUS - Displays the current network

communication status.

ETHERNET AUTO, 10MBPS HALF Select the desired combination

DUPLEX, 10MBPS FULL of communication speed and
DUPLEX, 100MBPS HALF transmission method.
DUPLEX, 100MBPS FULL

DUPLEX

TCP/ | ADDRESS STATIC IP, DYNAMIC, NO Sets a method for specifying an

IP MODE AUTO IP IP address.

IP ADDRESS | 000. 000. 000. 000 - Sets the IP address of this
255.255.255.255 equipment.

SUBNET 000. 000. 000. 000 - Sets the subnet mask of this

MASK 255.255.255.255 equipment.

DEFAULT 000. 000. 000. 000 - Sets the default gateway of this

GATEWAY 255.255.255.255 equipment.

HTTP | HTTP ENABLE, DISABLE Sets whether to use the HTTP
SERVER network server service.
PRIMARY 1-65535 Sets the primary port number to
PORT be used for receiving HTTP
NUMBER access from other clients.

Normally use the default port
number “80”.
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Q COPY

The following functions and settings are available on the “COPY” menu.

Menu Functions

Settings

Description

EXPOSURE

AUTO, Manual

Sets the default setting for the
density. You can change the
exposure from lighter to darker in
nine steps from -4 to +4.

EXPOSURE
LEVEL

AUTO LEVEL

-2to+2

Sets the center value for
adjusting the density with
EXPOSURE.

MANUAL LEVEL

-2 to +2

Sets the center value for
adjusting the density with
EXPOSURE.

ORIGINAL MODE

TEXT/PHOTO, TEXT,
PHOTO, BACKGROUND
ERASE

Sets the default setting for the
original mode.

MAXIMUM COPIES

9, 99, 999

Sets the maximum number of
copies to be allowed.

SORT MODE PRIORITY

NON SORT, SORT, ROTATE
SORT

Sets the default sort mode for
copy jobs.

AUTO 2-SIDED MODE

OFF, 1> 2 DUPLEX, 2> 2
DUPLEX, USER

Sets the default auto 2-sided
mode for copy jobs.

2IN1/4IN1 ORIGINAL SIZE

A3, A4, A5, B4, B5, FOLIO,
8K, 16K, LD, LG, LT, COMP,
13"LG, ST, 8.5SQ

Sets the default setting for the
original size when using the
“2IN1/4IN1” function.

ORIG. ORIENTATION

Portrait, Landscape

Sets the default setting for the
original orientation when using
the “2IN1/4IN1” function.

PAGE LAYOUT

2IN1:
|

4IN1; |= - |
=| |V [=] 3

Sets the order of the pages when
using the “2IN1/4IN1” function.

BACKGROUND

-4 to +4

Adjusts the density of the
original’'s background. It avoids
the back side of a 2-sided
original becoming visible on its
front side. You can change the
background from lighter to darker
in nine steps from -4 to +4.

SHARPNESS

-4 to +4

Emphasizes or blurs the outline
of the image. You can change the
sharpness from softer to sharper
in nine steps from -4 to +4.

OMIT BLANK PAGE

-3to+3

Sets the sensitivity level to detect
blank pages. The higher the level
is, the more likely the equipment
can detect blank pages. You can
specify the sensitivity level in the
range from -3 to +3.

CONTINUE SCAN

OFF, ON

Sets whether to continue
scanning when the scanning of
all the originals set on the RADF
is finished.
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Q0 SCAN

The following functions and settings are available on the “SCAN” menu.

Menu Functions Settings Description
COLOR MODE BLACK, GRAY SCALE, FULL | Sets the color mode to scan the
COLOR data.

COMPRESS LOW, MID, HIGH Sets the compression ratio for
the scanned image data.

2-SIDED SCAN SINGLE, DUPLEX Sets the type of originals to scan.

ROTATION [A]+[A] [=]-+[A] Rotates the scanned data to
save.

BLACK RESOLUTION 600dpi, 400dpi, 300dpi, Sets the resolution for the data to

SETTING 200dpi, 150dpi scan in the black mode.

ORIGINAL MODE TEXT, TEXT/PHOTO, Sets the type of the original to
PHOTO scan in the black mode.
EXPOSURE AUTO, Manual Sets the density level for the
scanned image data.

GRAY RESOLUTION 600dpi, 400dpi, 300dpi, Sets the resolution for the data to

SETTING 200dpi, 150dpi scan in the gray scale mode.

FULL COLOR | RESOLUTION 300dpi, 200dpi, 150dpi Sets the default setting for the

SETTING resolution when [FULL COLOR]
is selected for the color mode
setting.

ORIGINAL MODE TEXT/PHOTO, TEXT, Sets the default setting for the
PHOTO original mode when [FULL
COLOR] is selected for the color
mode setting.

OMIT BLANK PAGE -3to +3 Sets the sensitivity level to detect
blank pages. The higher the level
is, the more likely the equipment
can detect blank pages. You can
specify the sensitivity level in the
range from -3 to +3.

CONTINUE SCAN OFF, ON Sets whether to continue
scanning when the scanning of
all the originals set on the RADF
is finished.

L USB PRINT
The following functions and settings are available on the “USB PRINT” menu.
Menu Functions Settings Description

PAPER SIZE A3, A4, B4, B5, A5-R, FOLIO, | Sets the paper size to print files
LD, LG, LT, COMP, 13"LG, ST- | from a USB storage device.
R, 8.5SQ

2-SIDED SINGLE Prints on a single side of paper.
DUPLEX Prints on both sides of paper.
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QLIST

The following functions and settings are available on the “LIST” menu.

Menu Functions Settings Description

DEPARTMENT - Prints the department code and
the counter value. The printed
counter value is for the
department you specified in the
department code entry screen.
Enter the master code in the
department code entry screen if
you want to print counter values
of all the registered departments.

U0 DRAWER
The following functions and settings are available on the “DRAWER” menu.
Menu Functions Settings Description
DRAWER 1 A3, A4, A4-R, A5-R, 8K, 16K, | Sets the paper size for the
16K-R, B4, B5, B5-R, FOLIO, |drawer.
DRAWER 2 LD, LG LT, LT-R, ST-R, Sets the paper size for the Paper
COMP, 13" LG, 8.5 SQ Feed Unit.
O INFORMATION
The following functions and settings are available on the “INFORMATION” menu.
Menu Functions Settings Description
COUNTER ‘ TOTAL COUNTER | - Displays the total counter.
TONER REMAIN - Displays the toner remaining
information.
SERIAL NUMBER - Displays the serial number.
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Department Management

You can identify the number of output pages by copying, printing, and scanning by user groups (departments)
using the department management function.

When the department management function is enabled the department code entry screen is displayed before
using this equipment. This can also prevent improper use of this equipment.

P.15 “Preparation 1 - Turning Power ON”

You can register the department name and code from the [USER FUNCTIONS] menu.
1 Press [USER FUNCTIONS].

USER
FUNCTIONS JOB STATUS  SETTINGS

/@
|
L @ EXPOSURE @

@@ =
‘

3 Press V or A to select [DEPARTMENT CODE] and then press [>.

GENERAL

WALKUP SCREEN -~
TIMERS

DEPARTMENT CODE 4~

4 Press V or A to select [YES] and then press >.

DEPARTMENT CODE
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5 Specify the department number, name, and code.
P.142 “User Functions Menu List”

DEPARTMENT CODE

(NAME)
(CODE) v

You need to set the master code (department number: 01) before entering the department code.
The master code registration screen is displayed if you have not set the master code. H

MASTER CODE 01

(CODE)

ADD DEPARTMENT
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Job Status

You can confirm the status of jobs, delete jobs, and print files stored in a USB storage device.
1 Press the [JOB STATUS] button.

Press V or A to scroll the menu and then press > to enter the function menu.

USER
FUNCTIONS JOB STATUS  SETTINGS

ORIGINAL @
VODE @ EXPOSURE

P.152 “JOB STATUS menu items”

3 Press V or A to select the function menu and then start the operation.

JOB STATUS

SECURE RX
RESERVATION LIST A4

Hl JOB STATUS menu items

When you press the [JOB STATUS] button on the main screen, the JOB STATUS menu appears. On this
menu, you can confirm the status of each job, delete jobs, and print files from a USB storage device.
The table below shows the functions available on the JOB STATUS menu and the reference pages.

JOBS

Menu Functions Settings
PRINT CONFIRM Confirms the job status or deletes jobs.
DELETE P.153 “Confirming the job status and deleting
SCAN CONFIRM 1%
DELETE
USB PRINT Prints files saved in a USB storage device.

P.154 “Printing from a USB storage device”
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QO Confirming the job status and deleting jobs

You can confirm the statuses of print and scan jobs and delete jobs.

Confirming the job status

A A WON-

Press V or A to select [JOBS] and then press .
Press V or A to select [PRINT] or [SCAN] and then press [>.

Press V or A to select [CONFIRM] and then press .

Jobs in progress or those on the waiting list appear.

Press V or A to select the job whose status you want to confirm and then press >.
The status of the selected job appears.

After you have confirmed the status, press <1, [CANCEL] or [OK].
The menu returns to the previous one.

Deleting unnecessary jobs

1
2
3
4

Press V or A to select [JOBS] and then press .
Press V or A to select [PRINT] or [SCAN] and then press >.

Press V or A to select [DELETE] and then press >.
Jobs in progress or those on the waiting list appear.

Press V or A to select the job you want to delete and then press >.
A message asking you to confirm the deletion appears.

ARE YOU SURE?

YES

_

If you want to continue to delete the job, press A and select [YES]. Then press [OK].

The job is deleted.
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U Printing from a USB storage device

You can print PDF, JPEG or TIFF files saved in a USB storage device connected to this equipment.

* USB storage devices must meet the requirements below. However, some USB storage devices may
not be used with this equipment even though the requirements below are met.
- FAT16 or FAT32 format
- Single-partition (USB storage devices with multiple partitions are not supported.)
* Only files saved in the root folder of a USB storage device can be printed.
* Up to 99 files can be displayed in alphabetical order.
* Up to 20 characters of the file name can be displayed. The 21st and the subsequent characters are
displayed in dots.
* A JPEG file with a resolution is higher than 600 dpi cannot be printed.
* The compression format of TIFF files is compatible with JPEG/MH/MR/MMR.
* If photo images in a TIFF file have been printed in a grainy fashion, try carrying out the printing from a
client computer, and thus this phenomenon may be improved.
Only PDF files that have been scanned with the same equipment in the BLACK mode can be printed.
The encrypted PDF files cannot be printed.
A paper size cannot be set for PDF files. They are printed in the size in which they are scanned.
TIFF and JPEG files cannot be printed as being scaled according to the paper.

1 Connect a USB storage device to the slot of this equipment.

2 Select the paper size and set the duplex printing mode in [USB PRINT] of the USER
FUNCTIONS menu.
P.148 “USB PRINT”

The paper size setting is disabled for PDF files as they are printed in the size in which they are
scanned.

3 Press the [JOB STATUS] button.

USER
FUNCTIONS JOB STATUS  SETTINGS

@
[

8

i
ORIGINAL
VODE @ EXPOSURE ol

O

CANCEL OK

[

g

PQRS

7 |

[

* g
N

4 Press V or A to select [JOBS] and then press .
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5 Press V or A to select [USB PRINT] and then press .

Press V or A to select the file you want to print and then press [OK].
Printing starts.

Do not remove the USB storage device until printing finishes.
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When This Message Appears

A message appears when a problem occurs on the equipment. Find the message on the list below and follow
the instructions in the Countermeasure.

indicated by “***” is not
securely closed.

Message Meaning Countermeasure

MISFEED xxx An error code “xxx” and a Remove any misfed paper.
message for solving the P.160 “Paper Misfeed”
problem are displayed.

CHECK:PAPER SIZE | The incorrect paper size has | Remove paper from the bypass tray and load it
been set for paper loaded on | again so that the display shows “BYPASS PAPER
the bypass tray. SIZE”. Set the correct paper size. When you load

paper the size other than the standard ones,
select “CUSTOM?” for the paper size.

CLOSE *** Any cover of the equipment Close the cover securely.

DRAWER * EMPTY

The paper in a drawer
indicated by “*” has run out.

Load paper in the drawer.
P.21 “Loading paper in the drawer/Paper Feed
Unit”

COUNT OVER

The number of pages
scanned has exceeded the
maximum value.

Select “PRINT” on the LCD screen to copy the
data scanned so far. Select “CANCEL JOB” to
delete all the data scanned so far.

CALL FOR SERVICE

The repair or adjustment by
your service technician is
needed.

Contact your service representative.

Give the service technician the error code
(consisting of letters and numbers) that appears
in the upper right area of the LCD screen.

/\ CAUTION

Never attempt to repair, disassemble or
modify the equipment by yourself.

This could cause an electric shock, a fire or
serious injury. Contact your service
representative when the equipment is in an
abnormal condition or any malfunction is found.

TIME FOR
MAINTENANCE

The maintenance by your

service technician is needed.

Contact your service representative.

BYPASS EMPTY

Paper set on the bypass tray
has run out.

Load paper on the bypass tray.
P.23 “Loading paper on the bypass tray”

TONER IS LOW

There is only a little toner
remaining in the toner
cartridge.

There is still a little toner remaining in the toner
cartridge. Do not replace the toner cartridge until
“TONER EMPTY” appears on the LCD screen.

* The message may not appear because the
toner remaining in the cartridge does not lie
evenly.

* When the message appears, it is advisable
to purchase a new recommended cartridge
to prepare for its replacement.

ERROR : TONER

The toner cartridge is not
installed correctly.

Install the toner cartridge correctly.

The recommended toner
cartridge is not being used.

If you are using a toner cartridge other than the
one we recommend, the equipment may not be
able to detect whether it is installed or not. For
details of the recommended toner cartridge, refer
to the Safety Information.

TONER EMPTY

The toner in the toner
cartridge has run out.

Replace the toner cartridge with a new one.
P.169 “Replacing Toner Cartridge”

MEMORY IS FULL
PRESS ANY KEY

The built-in memory of the
equipment has become full.

Press any button on the control panel to delete
the scanned data.
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Message

Meaning

Countermeasure

CLEAR PAPER
OUTPUT TRAY:
PRESS START KEY

Approx. 100 maximum sheets
of paper have continuously
exited and the equipment
stops copying to prevent the
copied paper from overflowing
from the tray.

Remove the paper from the receiving tray, and
then press [START] to resume copying.

Press [CLEAR/STOP] to end the copy. When
“MEMORY CLEAR?” appears on the LCD
screen, select “YES”, and then press [START].

PLEASE WAIT
ADMINISTERED BY
PC

TopAccess has been closed
by clicking [X] (Close) on the
browser window instead of
[Logout] by a user who logged
in as an administrator
(Admin).

Turn the equipment power OFF and back ON, or
wait until the time set with TopAccess for [Web
General Setting] — [Session Timer] passes
(default: 10 minutes).

ERROR:PRINT

An error has occurred inside
the equipment.

Contact your service representative.

TO USB ERROR xxxx

Scanned data could not be
saved in the USB storage
device.

Scanned data could not be saved in the USB
storage device. Press any button on the control
panel to clear the error.
Tip
Use a USB storage device that meets the
following requirements. If you use the USB
storage device that does not meet the
requirements, try to use another USB storage
device that meets them.
- FAT16 or FAT32 format
- Single partition
- Storage space enough to save scanned
data
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Paper Misfeed

M Find the position of paper misfeeds

When a paper misfeed occurs in the equipment, the operation stops, the alert lamp blinks on the control
panel, and a message appears on the LCD screen to indicate the positions where the paper is misfed.

Press > and [OK] to select [Help]. Check the message, remove any misfed paper, and then press [START] to

resume copying.
P.142 “User Functions Menu List”

Tip
When a paper misfeed occurs in the equipment, the instruction to remove the misfed paper appears on the
LCD screen. Press A and V to scroll up and down to read the instruction.

l When paper misfeeds occur frequently

When paper misfeeds occur frequently, they may be due to one of the causes listed below:

* Unacceptable paper is used.
P.20 “Paper types not acceptable”

* The sizes of paper loaded in the drawer or on the bypass tray are not registered into the equipment
properly.
P.29 “Preparation 3 - Registering Paper Size and Type”

* More misfed paper is still remaining after the release of a paper misfeed.

* The side guides are aligned too tight or too loose to the paper.

* The height of the stacked paper is exceeding the indicators in the drawer.

l When removing misfed paper

Observe the following precautions when you remove misfed paper:

Do not tear misfed paper.
Remove misfed paper carefully with both hands. Do not pull the paper forcefully, otherwise the paper could
tear and cause a misfed paper. Make sure there are no torn pieces of paper left in the printer.

A\ CAUTION

Do not touch the fuser unit or the metal part around the unit.
When you remove misfed paper within the fuser unit, do not touch the fuser unit or the metal part around the
unit. If you touch the inside of the equipment, this could cause burns or any injury to your hands.

Do not touch the photoconductive drum.
When you remove the misfed paper within the transfer unit or the fuser unit, be careful not to touch the
photoconductive drum. This could stain the copy images.
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H Paper misfeeds on the Reversing Automatic Document Feeder (RADF)

1 Open the upper cover.

Paper Misfeed 161



5 Close the RADF.

6 Raise the feeder tray.

7 Turn the dial to remove the misfed original.

8 Lower the feeder tray.
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9 Close the upper cover.

H Paper misfeeds on the bypass tray

1 Release the lever on the left, and then pull out the misfed paper on the bypass tray. n
%/xg = -
N
\/

Check beneath the transport guide in the paper feeding area.
Check if any paper is misfed under the transport guide behind the transfer unit.
P.164 “Paper misfeeds inside of the side cover”
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H Paper misfeeds inside of the side cover

/N CAUTION

* Be careful not to catch your fingers between the equipment and the side cover.
This could injure you.
* Do not touch the fuser unit or the metal part around the unit.
If you touch the inside of the equipment, this could cause burns or any injury to your hands.

1 Open the side cover.

2 Remove the misfed paper behind transfer unit.

A\ CAUTION

Be sure not to touch the photoconductive drum when removing the misfed paper.

If you cannot see the misfed paper, turn the dial (green) of the transfer unit to remove the misfed
paper.

/.
Ji
7

AL
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3 If you cannot see the misfed paper or it is difficult to remove, open the drawer in which
you have loaded paper and remove it.

Be sure that the height of the stacked paper does not exceed the line indicated inside of the side n
guides. L

4 Close the drawer.

Lay down the transfer unit, and then press down the two fuser pressure release levers
(green) until they come to a stop.

Press down the levers fully until they stop.
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Release the misfed paper within the fuser unit.
Pull the misfed paper up or down as shown below depending on its position.

A\ CAUTION

Be sure not to touch the photoconductive drum when releasing the misfed paper.

Pulling it up Pulling it down

8 Return the transport guide and transfer unit to their original positions, and then close
the side cover.
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M Paper misfeeds within the Paper Feed Unit

Open the side cover and check if any paper is misfed behind the transfer unit.
P.164 “Paper misfeeds inside of the side cover”

2 Open the paper feed cover of the unit.

4 If it is difficult to find or remove the misfed paper, open the drawer of the Paper Feed
Unit.
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5 Check that the guide width is correct, there is no folded/curled paper or overloading,
and then close the drawer.

MAX % n
=

>PS<

==

—

/

Al

0

&L:_Lfil_@i

* Be sure that the height of the stacked paper does not exceed the line indicated inside of the side

guides.
* Do not allow any gap between the paper and the end guide in the drawer.

6 Close the paper feed cover of the unit and the side cover.
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Replacing Toner Cartridge

B When a message for replacement appears
When the toner cartridge runs out of toner, the message appears on the LCD screen and the alert lamp blinks
on the control panel.
Tip
When > is pressed, the procedure to replace the toner cartridge appears on the LCD screen. Press /A and
V to scroll up and down to read the procedure.

/N WARNING

Never attempt to incinerate toner cartridges.
Dispose of used toner cartridges in accordance with local regulations.

Do not touch the terminal of the toner cartridge.

This may cause the equipment not to recognize the toner cartridge
or may damage the terminal.

» Before inserting a new toner cartridge, check that the product name is “T-2309”.
* Do not touch the parts on the circuit board mounted on the toner cartridge because they may be
damaged.

1 Open the front cover.
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2 While holding down the green lever, pull out the toner cartridge.

/N WARNING

Never attempt to incinerate toner cartridges.
Dispose of used toner cartridges in accordance with local regulations.

Shake the new toner cartridge strongly with the label surface down to loosen the toner
inside.

4 Pull out the seal in the direction of the arrow.

5 Insert the toner cartridge along the rail.

Insert the toner cartridge until you hear a click sound.
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6 Clean the charger.
Hold the cleaning knob of the charger and pull it out toward you carefully until it stops. Then reinsert it in
its original position carefully. Repeat this procedure two to three times.

Check if the cleaning knob is fully inserted after cleaning.

7 Close the front cover.
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Before Calling Service Technician

When you encounter troubles, find the symptom listed below and follow the instructions in the

Countermeasure.

H General operation

Phenomenon

Usual cause

Countermeasure

The equipment does not
work at all.

The power is not turned
ON.

Turn ON the power of the equipment.

The power cable is not
plugged in securely.

Plug in the power cable securely.

The button does not
respond to my operation.

It has been a short time
since the power was
turned ON.

Wait for the completion of warm-up and then try
again.

The LCD screen is too
light/dark.

The contrast of the LCD
screen is not adjusted

properly.

Adjust the contrast.
P.142 “User Functions Menu List”

A message is displayed on
the LCD screen.

The equipment has
detected an error status.

See the meaning of the message referring to the
listing below.
P.158 “When This Message Appears”

“SAVING ENERGY”
appears on the LCD
screen.

The equipment is in the
low power mode.

Press any button on the control panel to cancel
this mode. Copying is enabled in the low power
mode.

P.16 “Saving energy when not in use - Energy
saving mode -”

The LCD screen is dim.

The equipment is in the
sleep mode.

Press any button on the control panel to cancel
this mode.

P.16 “Saving energy when not in use - Energy
saving mode -”

Copy functions cannot be
set.

Some copy functions that
cannot be set
simultaneously with others
have been set.

Some copy functions cannot be set together with
others.
P.184 “Copying Function Combination Matrix”

The equipment is not
recognized when it is
connected to a PC using a
USB cable.

The cable is not support
the USB2.0 Hi-Speed.

Use a USB2.0 Hi-Speed certified cable.

The equipment is
connected via a USB hub.

Connect the equipment with a PC directly by a
USB cable.

B Toner-related items

Phenomenon

Usual cause

Countermeasure

“TONER IS LOW” appears
on the LCD screen.

Toner is running out.

There is still a little toner remaining in the toner
cartridge. Do not replace the toner cartridge until
“TONER EMPTY” appears on the LCD screen.

“TONER EMPTY” appears
on the LCD screen.

Toner has run out.

Replace the toner cartridge with a new one.

“ERROR : TONER”
appears on the LCD
screen.

The toner cartridge is not
installed, or it is installed
incorrectly.

Install the toner cartridge correctly.

The recommended toner

cartridge is not being used.

If you are using a toner cartridge other than the
one we recommend, the equipment may not be
able to detect whether it is installed or not. For
details of the recommended toner cartridge, refer
to the Safety Information.

“TONER IS LOW” does not
appear on the LCD screen,
although toner is nearly
empty.

The recommended toner

cartridge is not being used.

For details of the recommended toner cartridge,
refer to the Safety Information.
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Phenomenon

Usual cause

Countermeasure

The equipment does not
become ready after the
toner cartridge is inserted.

The toner cartridge
inserted is not usable for
this equipment.

Check that the product name is “T-2507".

M Original/Paper-related items

Phenomenon

Usual cause

Countermeasure

Paper misfeeds.

The paper is unsuited for
the equipment.

Check if the paper is acceptable.
P.20 “Paper types not acceptable”

The paper size is not
registered properly in the
equipment.

Register the paper size properly.
P.29 “Preparation 3 - Registering Paper Size
and Type”

Misfed paper is located in
a place you cannot see
easily.

See the message on the LCD screen to recheck
the position where the paper misfeed has
occurred.

P.160 “Paper Misfeed”

There is no gap between
the side guides and paper
in the drawer, or the gap is
too wide.

Adjust the gap between the side guides and the
paper properly.

P.21 “Loading paper in the drawer/Paper Feed
Unit”

Multiple feeding occurs.

Sheets of paper clinging to
each other.

Fan the paper well and place it again.

H Image trouble

Phenomenon

Usual cause

Countermeasure

The copy image is light.

Toner has run out.

Replace the toner cartridge if the “TONER
EMPTY” message appears on the LCD screen.
P.169 “Replacing Toner Cartridge”

The copy density is set
lighter.

Make the density darker if you use the manual
copy density mode.

The copy image is dark.

The copy density is set
darker.

Make the density lighter if you use the manual
copy density mode.

The copied image is
stained.

The Platen Cover or the
Reversing Automatic
Document Feeder is not
lowered fully.

Lower it fully to block outside light.

The original glass or platen
sheet is dirty.

Clean them.
P.176 “Regular Cleaning”

The copy density is set
darker.

Make the density lighter if you use the manual
copy density mode.

Highly transparent
originals such as overhead
transparencies or tracing
paper are used.

Place a blank plain sheet of paper, the same size
as the original or larger, over the original.

The copy image is fogged.

There is a slight gap
between the original glass
and the original.

Lower the Platen Cover or the Reversing
Automatic Document Feeder fully so that the
original will contact with the original glass.

The paper is damp.

Replace with dry paper.

The copied text is blurred
depending on the type
(such as a map) of original.

Adjust the sharpness.
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Phenomenon

Usual cause

Countermeasure

The copy image is partially
missing.

The size or direction of the
paper and the original, or
the reproduction ratio is
not set properly.

Use paper of the same size as the original or set
the reproduction ratio suitable to the paper size.

The margin for binding is
too wide.

Adjust the image shift value again.
P.56 “Shifting the pages to the right or left”

The copy image has black
streaks in a horizontal
direction.

The charger is dirty.

Clean the charger.
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Regular Cleaning

We recommend you to clean the following items weekly, so that the originals can be scanned in unsoiled
conditions.

* Be careful not to scratch the portions in cleaning.

* When cleaning the surface of the equipment, do not use such organic solvents as thinner or benzine.
- This could warp the shape of the surface or leave it discolored.

* When using a chemical cleaning pad to clean it, follow the instructions.

1. Scanning area (surface of the long rectangular glass) / 2. Original glass
Wipe it with a soft dry cloth. If there are still stains remaining, wipe it clean with a piece of soft cloth which
has been moistened with water and then squeezed well.
Do not use liquids other than water (such as alcohol, organic solvents or neutral detergent).
3. Guide / 4. Platen sheet
Clean the surface as follows depending on the staining.
* Clean it with a soft cloth.
* Clean it with a soft cloth lightly moistened with water.
* Clean it with a soft cloth lightly moistened with alcohol, and then wipe it with a dry cloth.
* Clean it with a soft cloth lightly moistened with watered-down neutral detergent, and then wipe it with a
dry cloth.

You need to clean 1 (scanning area) and 3 (guide) only when using Reversing Automatic Document
Feeder.
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Cleaning Charger

If the inside of the charger is dirty, staining may appear on the copied image. Clean the charger following the
procedure below.

1 Open the front cover.

Clean the charger.
Hold the cleaning knob of the charger and pull it out toward you carefully until it stops. Then reinsert it in
its original position carefully. Repeat this procedure two to three times.

Check if the cleaning knob is fully inserted after cleaning.

3 Close the front cover.
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e-STUDIO2303AM/2803AM Specifications

Model name DP-2303AM/2803AM
Type Desktop type
Original glass Fixed

Printing (copying) system

Indirect electrophotographic method

Developing system

2-component magnetic brush developing

Fusing method

Two halogen lamp

Photosensor type

OPC

Original scanning system

Flat surface scanning system
(When the RADF is installed: Fixed scanning system by
feeding the original)

Original scanning sensor

CMOS

Scanning light source

LED

Resolution Writing 2400 dpi x 600 dpi (Smoothing process)
Scanning | 600 dpi x 600 dpi
Acceptable originals Sheets and books
Acceptable original size Original glass: Max. A3 or LD
RADF: Max. A3 or LD
Acceptable paper size Drawer A3, A4, Ad4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R,
ST-R, COMP, 13"LG, 8.5"SQ, 8K, 16K, 16K-R
Bypass A3, A4, Ad-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R,
ST-R, COMP, 13"LG, 8.5"SQ, 8K, 16K, 16K-R,
COM10, Monarch, DL
Acceptable paper weight Drawer 64 - 80 g/m2 (17 - 20 Ib. Bond)
Bypass 64 - 80 g/m2 (17 - 20 Ib. Bond) : for continuous feed

52 - 63 g/m?2 (14 Ib. Bond - 16 Ib. Bond), 81 - 216 g/m? (21 Ib.
Bond - 110 Ib. Index/80 Ib. Cover) : for single feed

Warm-up time

Approx. 18 seconds

First copy time (A4 or LT portrait)

A4: Approx. 6.4 seconds
LT: Approx. 6.5 seconds

Continuous copy speed

See P.181 “Continuous copying speed”

Multiple copying

Up to 999 copies

Excluded image width Copy Leading edge: 3.0+2.0 mm (0.12"+0.08")
Trailing edge: 2.0£2.0 mm (0.08"+0.08")
Both edges: 2.0£2.0 mm (0.08"+0.08")
Printer Leading edge: 5.0£3.0 mm (0.20"+0.12")
Trailing edge: 5.0+3.0 mm (0.20"+0.12")
Both edges: 5.0+3.0 mm (0.20"+0.12")
Reproduction ratio Actual size | 100+0.5%
Zoom 25 -400% (in 1% increments)
Storage capacity Max. 150 sheets or until the memory is full (TOSHIBA's own
chart)
Paper supply Drawer 250 sheets (80 g/m?, 20 Ib. Bond)
Bypass 100 sheets (80 g/m2, 20 Ib. Bond)

Loading capacity for the receiving tray

Approx. 100 sheets (80 g/m2, 20 Ib. Bond)

Toner density adjustment

Magnetic auto-toner system

Exposure control

Automatic plus manual selection from 9 exposure steps

Memory

512MB

USB interface

USB2.0 (Hi-Speed)

Environment (for normal use)

Temperature: 10 © - 30 °C, Humidity: 20 - 85% (No
condensation)
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Power requirements and power AC 220-240 V£10%, 8 A (50-60 Hz): 1.5 kW or less
consumption AC 120 V£10%, 12 A (60 Hz): 1.5 kW or less

(including optional equipments)

Dimensions (equipment only) 575 mm (22.6") (W) x 565 mm (22.2") (D) x 402 mm (15.8") (H)
Weight (including equipment and drum) Approx. 24.3 kg (53.6 Ib.)

Space occupied (equipment only) 943 mm (37.1") (W) x 565 mm (22.2") (D)

* These specifications vary depending on the copying conditions and the environment.
» Specifications and appearance are subject to change without notice in the interest of product
improvement.

H Continuous copying speed

sheets/min.
Paper size Paper source e-STUDIO2303AM | e-STUDIO2803AM
A4, A5-R, B5, LT, ST-R*! Drawer 23 28
Bypass tray 23 28
A4-R, B5-R, LT-R Drawer 19 19
Bypass tray 19 19
B4, FOLIO, LG, COMP, 13"LG | Drawer 16 16
Bypass tray 16 16
A3, LD Drawer 14 14
Bypass tray 14 14

*1 ST-R can be loaded only on the bypass tray.

* The values above are measured when originals are set on the original glass, 100% and nonsort multiple
copies are made.

¢ TOSHIBA-recommended paper is used for the values of the specifications above.

* The bypass copying speed is as listed above when specifying the paper size.

» This specification varies depending on the copying conditions and the environment.
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Specifications of Options

Reversing Automatic Document Feeder

Model name MR-3029

Copy sides 1-side, duplex

Number of originals 50 originals (80 g/m2, 20 Ib. Bond) or 9.5 mm or less in height (more than 80 g/m2,

(Ad) 20 Ib. Bond)

Feeding speed 37-111 mm/s

Acceptable originals A3, A4, A4-R, A5-R, B4, B5, B5-R, LD, LG, LT, LT-R, ST-R, COMP, 8K, 16K, 16K-
R

Paper weight 50 - 104 g/m2, 13 - 27 Ib. Bond

Power source Power supplied from the equipment

Dimensions 570 mm (22.44") (W) x 445 mm (17.52") (D) x 88 mm (3.46") (H)

Weight Approx. 4.5 kg (9.9 Ib)

Power consumption Approx. 40 W max.

Automatic Duplexing Unit

Model Name MD-0107

Acceptable Paper A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, ST-R, COMP, 13"LG,
8.5"SQ, 8K, 16K, 16K-R
(Non-standard sizes are not acceptable.)

Power Source 64 - 80 g/m2, 17 - 20 Ib. Bond

Weight Approx. 1.4 kg (3.1 Ib)

Paper Feed Unit

Model name MY-1043

Acceptable paper size | A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO, LD, LG, LT, LT-R, ST-R, COMP, 13"LG,
8.5"SQ, 8K, 16K, 16K-R (Non-standard sizes are not acceptable.)

Paper weight 64 - 80 g/m2, 17 - 20 Ib. Bond

Maximum capacity 250 sheets (80 g/m2, 20 Ib. Bond)

Dimensions 575 mm (22.64") (W) x 565 mm (22.24") (D) x 117 mm (4.61") (H)
Weight Approx. 5.5 kg (12.1 Ib)

TOSHIBA-recommended paper is used for the values above. Specifications and appearance are subject to
change without notice in the interest of product improvement.
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8 Appendix

Packing List

Packing list Safety Information
Quick Guide
Power cable

DVD
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